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INTRODUCTION 
TANDBERG Conferencing eXtensions for Microsoft Exchange (referred to as TCX) is an optional add-
on to the TANDBERG Management Suite (referred to as TMS) that allows you to fully integrate the 
scheduling functionality of TMS with your existing Microsoft Exchange deployment.  This integration 
gives users the ability to schedule video conferences and invite participants directly from their 
Microsoft Outlook clients while viewing availability information of resources regardless of where 
meetings are created. 
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Pre-Installation Information 
TCX synchronizes Microsoft Exchange Calendaring and TMS Scheduling by installing components in 
the backend servers of an Exchange Organization.  By installing in the backend, all users of the 
organization can benefit from a single installation.  TCX is installed on an Exchange 2003 or 2007 
Server in the organization, and accounts integrated with TMS must be hosted by the Information 
Store of that server.  
Only one TCX installation is required per Exchange Organization as long as all users have access to 
the resource accounts hosted by that server.  There should never be more than one TCX installation 
in a single domain.  Installations with complex security models where users cannot see accounts 
across domains should contact their TANDBERG sales representatives for assistance planning more 
complex deployments.  For more information on how TCX integrates with your Exchange 
Organization and details on server changes, please refer to the Changes and Impact of TCX 
Installation on Existing Servers section. 

Server Requirements 
The installation requirements vary based on if you are installing on an Exchange 2003 or 2007 server.  
The requirements assume you are installing on an operational Exchange Server and all Microsoft 
requirements for Exchange Server are satisfied. 

Exchange Server 2003 Installations 

 DETAILS 

Exchange 2003 Server w/Service 
Pack 2 

! Standard or Enterprise Editions 
! Exchange System Manager must be installed on the 

server 
! Latest Service pack recommended 

Windows Server 2003 32bit 
w/Service Pack 1 or later 

! Standard/Enterprise/Datacenter Edition all compatible 
! Server 2003 R2 also compatible 
! Latest Service pack recommended 
! Domain functional level Windows 2000 Native or higher 

Exchange Server 2007 Installations [*] 

 DETAILS 

Exchange 2007 Server w/Service 
Pack 1 or later 
 

! Standard or Enterprise Editions 
! The Server must have the Mailbox Server Role installed
! Latest Service pack recommended 
! Public Folders required to use Direct Resource Booking 

option or publishing custom form (optional) 

Windows Server 2003 64bit 
w/Service Pack 2 or later 

! Standard/Enterprise/Datacenter Edition all compatible 
! Server 2003 R2 also compatible 
! Latest Service pack recommended 
! Domain functional level Windows 2000 Native or higher 

Windows Server 2008 64bit ! Standard/Enterprise/Datacenter Edition all compatible 
! Latest Service pack recommended 
! Domain functional level Windows 2000 Native or higher 
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Domain Functional Level Note - The group permissions used on the calendars are not compatible 
with the “Windows 2000 mixed” domain level. If your domain is not Windows 2000 Native Mode or 
higher, you can not use the Direct Resource Booking mode until you apply your own set of 
permissions on the resource calendars by logging on to each mailbox using Microsoft Outlook. 
Connectivity between Exchange Server and TMS – The Integration requires that the Exchange Server 
where TCX is installed can open a HTTP/HTTPS connection to the TMS server.  Also required is that 
the Mail Server TMS is defined to use, can send emails to the Exchange server’s domain. 

[*]Microsoft only supports Exchange Server 2007 in 64bit installations for production use.  
Exchange Server 2007 32bit versions are provided for testing and evaluation purposes only.  
The 32 bit version of TCX can be used with 32bit Exchange Server 2007 test environments but 
is not supported for production use. 

Client Requirements 
Microsoft Outlook 2002 ! Latest Service pack recommended 

Microsoft Outlook 2003 w/Service 
Pack 1 or later 

! Latest Service pack recommended 

Microsoft Outlook 2007 ! Latest Service pack recommended 

Outlook Web Access ! Requires using the Asynchronous Booking Model – 
Direct Resource Booking not support in OWA 

! TANDBERG Custom Form not available when using 
OWA 

TMS Requirements 
Version ! TMS 12.0 or later 

Network ! HTTP (HTTPS optional) connectivity from the Exchange 
Server to TMS 

! TMS must be able to send emails to the Exchange 
Server’s domain 

Licensing ! One Exchange Integration License required per TMS 
system integrated 

or 
! One Application Integration License required per 

Exchange Server integrated with TMS 

Permissions required to perform installation 
Performing the TCX installation requires logging into the Exchange Server as a user with specific 
administrator permissions.  Before continuing, verify the user account you will use to perform the 
installation has the following permissions: 
! Windows Domain Administrator for the local domain or has delegated administrative access to 

the OU in Active Directory where all accounts are to be created 
! Windows Administrator of the local machine you are installing on 
! Exchange Full Administrator if using Exchange 2003 or Exchange Recipient Administrator for 

Exchange 2007 Installs 
For organizations where Active Directory and Exchange permissions are segregated and no 
exception can be made to use the TCX software, see the section Appendix - Using TCX Integration 
with Separate Admin Roles for information on installing via manual methods. 
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During the installation you will also setup a service user on the TMS Server.  If not reusing an existing 
account for the TMS Service User, you must supply user credentials that can create a new one.  The 
user credentials must have the following permission: 
! A Windows Administrator of the server TMS runs on 
! Must have a User Profile in TMS and be a member of the Site Administrator’s group 
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Installation and Upgrades 
Completing the installation of TCX requires completing the sections below.  Each section must be 
reviewed for both upgrades and new installations. 
! Upgrading from TANDBERG Microsoft Exchange Integration 
! Installation of Server Software 
! Initialization of Resource Accounts 
! Starting the Synchronizer 
! Configure Security Settings and Tuning 
! Optional - Deploying the TANDBERG Form 

Upgrading from a previous Integration installation 
Upgrading from TANDBERG Exchange Integration with Exchange Server 2003? 
! If you are currently using Exchange Server 2003 and plan to upgrade to TCX without changing 

to Exchange Server 2007, review the section Upgrading to TCX on Exchange 2003 for pre-
installation steps and information on changes in how your integration will differ with the new 
TCX product before continuing. 

Upgrading from TANDBERG Exchange Integration AND migrating to Exchange Server 2007? 
! If you are currently using Exchange Server 2003 and are upgrading your integration installation 

to an Exchange 2007 Server, review the section Upgrading to TCX and Migrating to 
Exchange 2007 for specific information on pre-installation needs changes in how your 
integration will differ with the new TCX product before continuing 

Upgrading from an earlier version of TCX and not changing Exchange Server versions? 
! If you are running an earlier version of TCX and not changing Exchange Server versions, you 

can continue with the installation steps as normal and the installer will handle your existing 
version automatically. 

Installation of Server Software 
If reinstalling or upgrading the software on a server where TCX was previously installed, the installer 
will automatically read the existing settings from the server’s registry and skip steps where it does not 
need additional user input.  Because of this, not all steps listed below may be shown.  If any of the 
previous installation’s values need to be changed, these can be changed using the Configuration 
Utility post-installation. 
1. Log into the Windows console of the Exchange Server where TCX will be installed.  Close all 

other running programs and any security/anti-virus software that may hinder installing the 
software. 

2. Launch Setup File - The TCX installer is located on the TMS installation media.  Open the index 
page by double-clicking browse.bat.  Click the link to Install TANDBERG Conferencing 
eXtensions for Microsoft Exchange to start the installation program. 

Note:  There are separate installers for 64bit installations and 32bit installations – Please use 
the appropriate link for your server type. 

3. Detecting a previous version - The installer will search for an existing installation of TCX and if 
found, will prompt if you wish to upgrade the existing installation.  Click Yes to continue.  The 
installer will automatically reuse settings it finds on the server. 

4. Component Check - The installer will verify all the required Microsoft software components are 
installed on the server, and if not will present a list of components that must be updated.  The 
installer will complete this task for you automatically (requires Internet Access), but may require 
a restart of the server after the installation is complete. 
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5. Installation Wizard - A welcome window will appear on the screen. Click the Next button 

 

6. Read and Accept the License Agreement - Read the License Agreement and select the ‘I 
accept the terms…’ option.  Click Next to continue.  Selecting ‘I do not accept the terms…’ or 
clicking Cancel will terminate the installation. 
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7. Set the installation folder - Select the destination folder where the software should be installed.  
To accept the default location, click Next to continue.  Otherwise, click Change to specify a 
custom installation path and click Next afterwards to continue. 

 

8. Select a Domain Controller - The installer will detect all domain controllers available to the 
Exchange Server and present them in a drop-down list.  The domain controller selected will 
used by TCX software when interacting with Active Directory.  Select your desired server from 
the drop-down list if necessary, and click Next to continue 

 

© 2009 TANDBERG  Page 10 of 86 



  TANDBERG Conferencing eXtensions for Microsoft Exchange – Administrator Guide 

9. Configure the Service User for Exchange - Next the installer must configure the service account 
to use on the Exchange Server.  The installer’s choices will vary depending if an existing 
service account is found and if not, what choices you make to specify a new account.  Each 
path is outlined below: 

The service account used must be allowed to have the ‘Log on as Batch Job’ permission in the 
local security policy.  Ensure there are no Group Policies that would override the configuration 
of this permission. 

 

Installer finds an existing account 

If a service account exists from a previous installation or manual configuration, it will automatically be 
detected and you are prompted to accept this user. 

To not re-use this account, you must click Cancel and remove the custom attribute from the account’s 
mailbox or delete the account and mailbox all together and restart the installation. 
To continue and use this user, click Next.   
The next screen presents choices for the service account’s password.  The TCX software must know 
the password for the service user.  Select from the available options:  Reset the Password to a strong 
password, Supply a new password or Supply the existing password to the account.  Make your 
selection, filling in the password fields if necessary and click Next to continue. 

© 2009 TANDBERG  Page 11 of 86 



  TANDBERG Conferencing eXtensions for Microsoft Exchange – Administrator Guide 

No Existing Account Found 
If no pre-configured service account is found, the installer will prompt if you wish to create a new 
account, or reuse an existing Active Directory account.  The installer’s steps will update depending on 
the option chosen. 

ate a new 
account, or reuse an existing Active Directory account.  The installer’s steps will update depending on 
the option chosen. 

Steps to create a new service account (Recommended) Steps to create a new service account (Recommended) 
a) Select I want the installer to create the account and click Next a) Select I want the installer to create the account and click Next 
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Specify the OU where the account should be created.  Click the Browse button to locate which 
Organizational unit the account should be placed in.  Select the OU you wish to use, or click 
New to create a new OU.  Click OK once you have made your selection.  Then click Next to 
continue.   

b) Select which mailbox store should be used for the mailbox of the account.  The drop-
down list will show all available databases on the local Exchange Server.  Select one and 
click Next to continue. 

 

c) The installer will create a new account TMS-Service with a strong password in the 
specified OU with a mailbox configured as needed for use with TCX in the mail database 
specified. 

Steps to use an existing domain account (Manual Configuration) 
a) Select I want to use an existing domain account.  To use this option, the existing account 

must be a member of the local domain, must not have an existing mailbox on another 
server, and must have the ‘Log on as Batch Job’ permission in the server’s Local Security 
Policy[*].  Click Next to continue. 

See http://technet.microsoft.com/en-us/library/cc739028.aspx for assistance on assigning user 
rights for your local computer] 
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b) Locate the existing account.  Click the Browse button to open a directory browser.  
Locate the account by browsing or using the Search button.  Select the Account and click 
OK. 

 

c) The screen will update to show your selected account.  Click Next to continue. 
d) Select which mailbox store should be used for the mailbox of the account.  The drop-

down list will show all available databases on the local Exchange Server.  Select one and 
click Next to continue. 

 

e) Set the Service User’s password.  The TCX software must know the password for the 
service user.  Select from the available options:  Reset the Password to a strong 
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password, Supply a new password, or Supply the existing password to the account.  
Make your selection, filling in the password fields if necessary and click Next to continue. 

 

f) The installer will create or update the user’s mailbox in the specified database store and 
configure it for use with TCX. 

10. Select the Service Account for TMS - Next the installer must configure the service account to 
use on the TMS Server.  You have the option to let the installer detect a previously used 
account and create a new account if needed (recommended), or manually specify an existing 
account on the TMS Server.  The installer’s steps will update depending on your selection. 

Alternative 1 (Recommended): Let the installer detect and create if needed. 
a) Select Let the installer create a service account if needed and click Next. 
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b) Enter the network address to the TMS server, along with a set of user credentials that 
has the appropriate administrator permissions on the TMS server as outlined in the start 
of this section.  The Use HTTPS checkbox can only be used if your server has been 
configured to use HTTPS1.  Fill in the fields and click Next to continue. 

 

The installer will look for an existing service user account on the Windows server based on your 
domain’s email.  If one is found, the installer will re-use it, otherwise the installer will create a new one.  
If needed, the installer will create a local Windows user account tmsconfuser on the TMS server, 
setup a TMS profile for the user, and assign it permissions within TMS needed to operate with TCX. 

Alternative 2: Manually specify an existing TMS service account (Manual Configuration) 
a) Select I have created a service user on the TMS server and click Next. 

                                                      
1 Please see the TANDBERG document titled Implementing Secure Management (HTTPS) for more 
information on configuring TMS for HTTPS 
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b) Enter the network address to the TMS server, along with the user name and password of 
the existing service account.  The Use HTTPS checkbox can only be used if your server 
has been configured to use HTTPS2.  Fill in the fields and click Next to continue. 

 

When reusing an existing account, the user’s TMS profile must be configured for TCX manually.  
Open a web browser and log into your TMS server with a username that is a Site Administrator.  Edit 
the user’s profile under Administrative Tools >User Administration > Users.   In the account’s 
profile, set Exchange Integration Service Account to Yes.  Set the user’s email address to the 
Exchange Service Account’s (the TMS-Service user) email address.  Ensure the user is a member of 
a TMS group that has the Book on behalf permission set in the Group Permissions.  Save the 
changes to the user’s profile.  You can close your web browser and return to the TCX installer. 

                                                      
2 Please see the TANDBERG document titled Implementing Secure Management (HTTPS) for more 
information on configuring TMS for HTTPS 
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11. Start Installation - The installer now has all the information needed to complete the installation.  
Click Install and the installer will complete the necessary software and configuration setup on 
the Exchange Server. 

 

12. Finish Installation - Once complete, a Finish screen is displayed. 

 

Leaving the checkbox marked will automatically launch the Configuration Utility so the next portion of 
the installation can be completed.  Click Finish to close the installer and launch the Configuration 
Utility to complete the next phase of the installation. 
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Initialization of Resource Accounts 
Each TMS system that you wish to be scheduled from Exchange will have a Domain user account 
and mailbox in the Exchange environment.  The accounts must be configured with specific properties 
and settings to operate with TCX.  The Configuration Utility installed as part of TCX allows creation, 
configuration, and management of these accounts.   Additionally, the Configuration Utility is the tool 
used to change any behaviors of the TCX installation.  The configuration utility can be found in the 
Start Menu, under Programs > TANDBERG > TANDBERG Conferencing eXtensions for 
Microsoft Exchange > TANDBERG Configuration. 
As part of a first time installation, you must configure and initialize the Exchange mailboxes that will 
represent the TMS systems to integrate.  For upgrades, your existing accounts will automatically be 
reused, but launching the Configuration Utility is required to allow the diagnostics to be run on your 
existing accounts.  If no new accounts are to be added, upgrade users can skip to the next section 
once they have opened the Configuration Utility at least one time and allowed the tool to repair their 
existing accounts. 
To fully use the Configuration Utility, the logged in user must be a Domain Administrator and 
Exchange Full Administrator (or Exchange Recipient Administrator for Exchange 2007 Installs). 

Have existing resource or equipment accounts you already use for 
scheduling? 
The configuration utility can automatically create new Active Directory accounts and mailboxes as part 
of the setup process for enabling TMS systems in Exchange.  If you have existing Exchange 
Resource or Equipment mailboxes you currently use to represent video systems or rooms from TMS, 
you have the option to let the Configuration Utility reuse the existing accounts.  The Configuration 
Utility will reconfigure them as necessary to work with the TCX integration including synchronizing the 
existing schedules between TMS and the account’s calendar.  This allows you to migrate from your 
Exchange-only model to an Exchange+TMS implementation.  To reuse accounts in this manner, the 
account mailboxes must be prepared before attempting to configure them with the TCX utility. 

Preparing Existing Mailboxes for use with TCX 
1. The resource account’s Active Directory user account must be in the same domain as the 

Exchange Server where TCX is being installed.  If the existing account is in another domain, 
migrate the user account to the local domain, or re-associate the existing mailbox to a local 
user account.  Please be sure to allow sufficient time for domain replication when moving 
accounts.  See Microsoft documentation for assistance, such as using the ADMT Tool to 
migrate accounts. 

2. The mailbox must be moved to a database located on the Exchange Server where TCX was 
installed.  Use the Exchange Management Console or shell to move the mailboxes.  See this 
Microsoft article for assistance on moving mailboxes for Exchange 2007 or this article for 
Exchange 2003 

3. If using Exchange 2007, if the mailbox is not already an Exchange 2007 Resource mailbox, 
convert it to a Resource mailbox using the Exchange Management Shell.  Example:  
set-Mailbox -Identity:ResourceName -Type:Room 

Once prepped, the accounts can be selected when enabling a TMS system in the steps below. 

Enabling TMS Systems in Exchange 

Once TCX Integration has been installed and operational, any new systems added to TMS that 
will be integrated with Exchange should not be booked in TMS until after they have been 
integrated with Exchange using the Configuration Utility. 

Start up the Configuration Utility from the Start Menu.  The utility is found at Programs > TANDBERG 
> TANDBERG Conferencing eXtensions for Microsoft Exchange > TANDBERG Configuration. 
As part of the start-up, the utility will perform a series of self-checks and diagnostics on the TCX 
configuration and the configured accounts.  The utility will self-repair any issues it can, and will report 
any errors to the user. 
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Define Calendar Security Groups 
If you intend on granting calendar permissions to groups of users (required if using Direct Resource 
Booking) you should define the default security groups before continuing so they will be added to all 
accounts you enable.  These permissions also allow users to directly interact with the calendars of 
resource accounts if desired. 
1. Switch to the Resource Defaults tab. 
2. Under Resource Calendar Permissions, use the Browse button to select an existing security 

group from Active Directory for each setting.  In the Browse window, there is also an option to 
create a new security group if needed. 
a. Editor Permissions – Members of the specified group will be able to edit meetings in 

resource calendars created by all users. 
b. Author Permissions – Members of the specified group will be able to create meetings in 

resource calendars, but only edit their own meetings - not those created by other users. 
3. Switch back to the Operations tab when complete to continue. 

The initial screen displayed shows an overview of systems found in TMS and any linked 
accounts in Exchange.   
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The left hand column represents all endpoints, rooms, and recording devices found in the configured 
TMS Server.  The right hand column lists all Exchange accounts that have been determined to be 
integrated with TMS via TCX. 
Select one or more TMS systems you wish to enable in Exchange from the left hand list.  Use the shift 
or control keys to select multiple systems at once.  Click the ! button. 
A new window appears which walks you through the Active Directory configuration for each selected 
system. 

 

For each selected system, this dialog walks you through creating a new Active Directory account and 
mailbox OR associating the system with an existing Active Directory account and mailbox.  Use the 
Next/Previous buttons to switch between systems.  The current system being configured is displayed 
in the top left.  The dialog allows you to choose an option for each selected system individually.  
When multiple systems were selected, the OK button will be disabled until a choice has been made 
for each system. 

WARNING:  Account creation/deletion/changes may take time to replicate through your Active 
Directory.  When changes are made outside of the Configuration Utility, depending on your 
Active Directory design these changes may take upwards of an hour to replicate across domain 
controllers.  If you experience errors or inconsistencies with account creation, please shutdown 
the Configuration Utility and allow time for your Active Directory changes to propagate. 
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Select the account options for each system as follows. 
1. Use the Next/Previous buttons to select the desired system. 

ALTERNATIVE A ALTERNATIVE B 

To create a new account for the system: To use an existing account 

Ensure Create an AD account… is selected.  The 
center panel displays a list view of your Active 
Directory’s organizational structure.  Expand the 
tree if necessary and highlight the Organization 
Unit (OU) where the new account should be 
created.  The mailbox and Active Directory user 
will automatically be created by the utility3.   If 
you wish to use these same setting for the 
remaining accounts to be added, click Create the 
remaining accounts in this folder button, else 
use the Next/Previous buttons to switch to the 
next system.    

This option will reconfigure an existing AD 
user account and mailbox to be associated 
with the TMS system.  Select Use an 
Existing AD Account.  The center panel will 
show you your domain’s organizational 
structure.  Navigate the tree to find the 
desired AD Account or use the Search 
feature.  Only user accounts that have their 
mailbox on the local server will be 
displayed.  Click on the user account you 
wish to associate to this TMS system. 

If an OU has more then 1,000 entries, only the first 1,000 will be displayed.  Please use the 
Search option when OUs are very large. 

2. Repeat the above steps using the Next/Previous buttons to toggle between the systems until a 
choice has been made for each system. 

3. Click the OK button to continue. 
In Exchange Server 2003 Installations, the utility will ask you for a password to use for the newly 
created accounts4.  The password entered will be used for accounts that are to be created.  Marking 
the Reset password for all… checkbox will also set the password for accounts that are being re-
used.  

The password for resource accounts is not needed by users or in normal use.  It is only for 
administrators that may wish to log into the account/mailbox directly.  The resource account 
passwords can be changed using standard AD tools afterwards without affecting the TCX 
integration. 

                                                      
3 The account will be created with the username of TMS-<id> where <Id> is the TMS System ID.  The display 
name of the AD user will be set to the System Name in TMS.  The mailbox will be created in the Mail Store 
designated during installation. 
4 This is only for Exchange Server 2003 Installations – Exchange Server 2007 installations will create an AD 
account with no password and the user account will be disabled as is normal for resource accounts in Exchange 
2007 
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Review selections - After choices have been made for all selected systems, a window will present a 
summary display of your choices. 

 

If the information is correct, click OK, or if alterations are needed click the Edit button to return to the 
previous screen. 
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If one or more of the systems imported were associated with existing accounts, you will be asked if 
existing meetings events from the accounts’ Calendars should be imported into TMS.  This ensures 
the resources’ calendars and TMS are in synch.  

 

Clicking Yes will cause all existing bookings in the Resources’ calendars to be booked in TMS.  
Clicking No will skip this step.  If there are any issues booking an existing meeting, the meeting’s 
organizer will receive an email detailing any actions necessary. 

Meetings with no end date can not be booked in TMS and will not synchronize to TMS.  After 
TCX is installed, any meetings of this type should be edited using Outlook to a new meeting 
with a fixed end-date. 

The configuration tool will now perform the tasks as instructed, and a status screen shows the 
progress of the individual systems and the overall progress. 

 

Note: This process can take some time depending on the number of systems you are importing 
and design of your Active Directory. 

When complete, click the OK button and the Operations tab will be displayed with the newly added 
systems in the right-hand column. 
Once all systems have been enabled in Exchange, continue to the next section to start synchronizing 
TMS and Exchange. 

Starting the Synchronizer 
The Synchronizer is an Integration component that runs on the Exchange Server that is responsible 
for keeping the Exchange calendars up to date with bookings and changes made in TMS.   
The synchronizer is setup by the Installer but is idled in new installations until the administrator has 
enabled all the systems in Exchange using the Configuration Utility.  Once all systems have been 
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enabled in Exchange using the Configuration Utility, the Synchronizer must be started.  In upgrade 
situations, the Synchronizer’s state is saved, but is idled until it is activated again.   
You can identify if the Synchronizer has been started by checking the button in the Configuration 
Utility > Operations tab.  The button will be labeled Restart Synchronizer if the Synchronizer is 
already running.  If so, no further action is necessary and you can continue to the next section.  If the 
button says Start Synchronizer or Reactivate Synchronizer, the Synchronizer must be started. 
For new installations, to start the Synchronizer: 
1. Open the Configuration Utility. 
2. In the Operations tab, click the button labeled Start Synchronizer or Reactivate 

Synchronizer. 
3. You will be prompted if with a warning regarding starting the Synchronizer before systems are 

configured.  Click Yes to start the synchronizer. 
The Synchronizer will work in the background to update the Exchange Calendars of integrated 
systems with all meetings that exist for those systems in TMS.  This process can take several hours 
when the Synchronizer is initialized in installations with lots of scheduling activity.  
The resource account’s calendars will not have complete free/busy information for all future meetings 
until the Synchronizer has processed all meetings and caught up, but you do not have to wait for this 
to be complete before continuing the installation and using the product.  The TCX integration will 
properly reject new meeting requests that would conflict even if the free/busy and resource calendars 
are not up to date yet. 
Administrators should continue to the next section to complete the setup of their permissions and 
controls they want in place for resource scheduling. 

Configure Security Settings and Tuning 
Once installed, administrators should review any security restrictions they wish to implement with 
booking of the integrated resource accounts.  How permissions are controlled depends on what type 
of Exchange Server TCX is installed onto.  Guidance is provided below, broken down based on the 
version of Exchange you have installed onto.  

Exchange 2003 Installations 
For Exchange 2003 installations, access to booking the resources depends on which booking model 
is selected. 
In the synchronous mode, booking will be limited to users who are members of the User group 
assigned Author access in the Configuration Utility.  In new installations, this group may be empty and 
users will not be able to book these systems until this group is populated.  Configure this group’s 
membership in Active Directory using the AD Users & Computer snap-in as desired to enable users to 
start booking. 
In the asynchronous mode, booking access is controlled by Delivery Restrictions where you can 
define who can or can not send email to the resource account.  By blocking mail sent by a user, that 
user can not send an invite to the account and attempt to book it.  The User Group defined in the 
Configuration Tool has no impact on Delivery Restrictions and should not be used to try to limit 
booking access when Asynchronous Booking is enabled.  Members of the defined User Group will still 
have access to the calendar directly so be aware of potential mismatches.  For more information on 
configuring Delivery Restrictions please see the Microsoft article – How to Set Restrictions on a User 
http://technet.microsoft.com/en-us/library/aa998925(EXCHG.65).aspx 
Membership in the security group defined as Editor access have the additional ability to edit existing 
meetings in the resource’s calendar, including meetings created by other users.  Configure this 
group’s membership in Active Directory using the AD Users & Computer snap-in as desired. 

Users may have to log out and back in before group membership changes are effective on their 
client computer. 
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Exchange 2007 Installations 
For Exchange 2007 installations, access to booking the resources is controlled via Resource Booking 
Policies.  The default setup on accounts will have AllBookInPolicy set to ‘true’ meaning all users can 
book the resource as long as the request falls within the restrictions defined on the resource account.   
New accounts created by the Configuration Utility will have the default Microsoft Exchange restrictions 
enabled.  These will limit how a user can book a meeting from Outlook, but will not limit bookings 
made from TMS or directly in the Resource’s calendar.  Administrators may need to tune these 
restrictions to their desired values to control booking by Outlook users. 
Administrators may configure the standard CalendarSettings of the Exchange resource accounts to 
their desire, including setting up Delegates and configuration for handling In-Policy and Out-of-Policy 
requests.  Administrators should not modify the following settings and leave them as configured by 
the Configuration Utility: 

MAILBOXCALENDARSETTING PARAMETER CONFIGURED VALUE 

AutomateProcessing AutoAccept 

Identity <domain>/TMS-<systemId> 

 
For more information on Managing Resource Scheduling Parameters see: 
! Managing Resource Scheduling - http://technet.microsoft.com/en-us/library/aa996338.aspx 
! Set-MailboxCalendarSettings - http://technet.microsoft.com/en-us/library/aa996340.aspx 

Optional - Deploying the TANDBERG Form 
TANDBERG supplies a custom appointment form that can be use by Outlook clients to gain additional 
functionality when creating or editing meetings such as specifying conference parameters and adding 
external participants.  This form replaces the default Appointment form used in the Outlook client.  
Use of the form is optional.  If you do not wish to make the form available to your clients, you can skip 
this chapter.  Making the form available can also be added any time in the future to your installation. 
It is recommended to place the TANDBERG form under the Organizational Forms Library in order to 
be made available for all Outlook clients in your network.   If an Organizational Forms Library already 
exists on your Exchange server, this one can be used. If not, one has to be created before importing 
the custom form.  The advantage of using the Organizational Forms Library is it allows you to make 
the form available to all users with a single process and allow future updating of the form 
automatically for users. 

Alternatively, users can load the form manually per Outlook client, by performing the steps in 
the Configuring clients to use the Form section and specifying a local copy of the 
VideoConference.oft file.  This method skips the Organizational Form Library and Publishing, 
so any future updates to the form must be manually completed by repeating the steps to 
specify the form to use. 

Deploying the form is broken into three phases: 
! Creating the Organization Forms Library. 
! Publishing the Form. 
! Configuring clients to use the Form. 
Each should be completed for new installations that wish to use the TANDBERG form.  For customers 
upgrading TCX without changing your Exchange Server version, only the Publishing the Form section 
is necessary.  The other sections were completed in your previous installation. 

Creating the Organization Forms Library 
If using Exchange 2007, the installation steps have changed significantly due to Public Folder 
changes in Exchange 2007 and will vary based how Exchange was installed.  Please chose one of 
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the two sections below that describes your Exchange environment - Exchange Server 2003 Only 
Environments or Exchange Server 2007 Environment (Mixed or Pure) 

Exchange 2007 Environments (Mixed and Pure) 
Exchange Server 2007 Environments are not dependant on Public Folders and therefore may not 
have them installed and therefore lacking the existing infrastructure to support the Organizational 
Forms Library.  The presence of existing Public Folders in Exchange 2007 environments depends on 
how Exchange 2007 was installed and will alter the steps required to be able to publish the 
TANDBERG form. 
If Exchange Server 2007 was installed along side or into an Exchange Server 2003 organization, the 
first 2007 server would have had a public folder database created and configured to replicate with the 
existing Public Folders.  In these cases, the existing Public Folder Database can be used, and 
replication should already be configured between the Public Folder Databases in Exchange 2003 and 
Exchange 2007. 
In these environments, if an Exchange 2003 Server is available, an administrator can follow the 
instructions in the section below for Exchange Server 2003 organizations and perform the steps on 
that server.  Forms will replicate to the Exchange 2007 Server and therefore be available to all 
Outlook versions.   
If using an Exchange 2003 server is not an option, use the steps provided in Appendix - Creating 
the Organization Forms Library in Exchange Server 2007 for instructions on creating the 
Organizational Forms Library in this type of environment.. 

Exchange Server 2003 Only Environments 
Be sure you are logged to the Exchange Server with full Exchange administrator rights.  
1. Open the Exchange System Manager. 
2. Go to Administrative Groups and then select the group containing the Exchange Server on 

which you just installed the Exchange Integration component. Normally this would be the 
Administrative Groups/First Administrative Group. 

3. Select Folders5 followed by Public Folder. Right-click on Public Folder and select View System 
Folders. 

                                                      
5 ‘Folders’ may reside on root level if the Exchange System Manger is not configured to show 
administrative groups 
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4. While viewing the System Folders, right-click on EFORMS Registry and select New > 
Organizational Form. 
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A property page for the new Organizational Form library will be displayed.  

 

5. Fill in a suitable name of your choice and (optional) description of the Organizational Forms 
Library.  

6. Choose English (USA) as E-forms language. 
7. Press OK to save Organizational Forms Library. 

Note: If the English (USA) language is not listed, a Forms Library for that language already 
exists and another can not be created.  In this scenario, you must use the existing folder to 
publish the form.  Right-click on any folder listed under EEFORMS REGISTRY,select 
Properties and find which is using English(USA) and use that existing folder for the remaining 
steps. 
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8. In order to publish the TANDBERG form in the Organizational Forms Library, an Outlook user 
needs to be granted “owner” permissions to the Organizational Forms Library.  This is done by 
right-clicking on the created folder, select Properties. In the pop-up window, select the 
Permissions tab. 
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9. Click the Client Permission button and a pop-up window appears 

 

It is recommended only to give one single end user the ‘owner’ permission (preferably an 
administrator), and use this user for publishing the form. Users you wish to have access to the form 
need a minimum of ‘Read’ permission granted.  By default, users will have this read permission by the 
Default entry being granted the ‘Reviewer’ role. 
10. Using the Client Permissions window, add a user and set its role to ‘Owner’ as necessary and 

add any desired User Groups with ‘Reviewer’ Role if necessary. 
11. Click OK to save the permissions, and OK again to save the properties of the new 

Organizational Form. 

Publishing the TANDBERG Form 
Once the Organizational Forms Library is in place, the TANDBERG form is ‘published’ using an 
Outlook client logged in as the user you assigned ‘owner’ permissions to the Form Library. 
On the server where the Integration was installed, locate the ‘Video Conference Form’ folder created 
in the Installation path, normally C:\Program Files\TANDBERG\Conferencing eXtensions for 
Microsoft Exchange\Video Conference Form  .In this folder is the file VideoConference.oft .   
1. Copy the VideoConference.oft file using the method of your choice to a client computer with 

Outlook installed. 
2. Using Outlook, log in as the user you assigned ‘owner’ permission to. 
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3. Locate the OFT file on the computer, and double-click it to open it.  It will open a form in 
Outlook that looks like the standard Appointment form except there is an extra tab labeled 
TANDBERG 

 

If you get a warning saying the custom form could not be opened, or the form does not display the 
TANDBERG tab the form must be opened using an alternative method due to changes in Outlook 
security 
Alternative Method to Open Form 

a. Close the Appointment form if it is currently open 
b. In Outlook, Select from the File Menu > New… > Choose Form… 
c. Change the Look In dropdown menu to User templates in File System 
d. Click the Browse button to locate the folder where you copied the OFT file to and click 

Ok. 

 

e. VideoConference should be seen in the list, highlight it and Click Open 
f. You can now continue with the normal publishing steps 
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4. Select from the Menu bar, Tools > Forms > Publish Forms as ... as shown in the picture. 

 

5. In the new window, change the Look In dropdown menu to Organizational Forms Library 
6. Enter names in the two fields exactly as described below (case sensitive): 

! Display name: Meeting 
! Form name: VideoConference 
! The screen should look like the image below.  Click Publish when complete 

 

The form is now published and available for users to choose as their appointment form. 
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Configuring clients to use the Form  
Publishing the form makes it available to users, but does not automatically force their Outlook client to 
use the form.  Configuring Outlook to use the form is a one-time client configuration that can be done 
by each user, or through making changes to the Microsoft Windows Registry.  Registry changes can 
be done automatically via methods such as Group Policy. 
Reference Material for Registry and Bulk Changes 
Microsoft utility to create registry keys to change the default form - 
http://support.microsoft.com/kb/241235/EN-US/ 
3rd party article about the Microsoft Utility6 - 
http://www.outlookexchange.com/articles/Santhosh/outlookforms.asp 
Manually configuring clients to use the form 
To have a user manual configure their client, have each user complete the following steps: 
1. Open your Outlook Client 
2. From the Folder View, Right-click the Calendar icon and select Properties. 

 

3. The Calendar Properties window will open with the General Tab selected 
4. Select Forms… from the drop-down menu for the When posting to this folder, use option 
5. A Pop-Up will open.  Ensure the Look In drop-down menu, has Organizational Forms Library 

selected 

                                                      
6 The examples in this document reference other forms, the TANDBERG form replaces the IPM.Appointment 
form 

http://support.microsoft.com/kb/241235/EN-US/
http://www.outlookexchange.com/articles/Santhosh/outlookforms.asp
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6. An entry will be displayed named Meeting.  Select it and click the Open button 
7. You will be returned to the Calendar Properties page.  Click Ok to save your changes 
The client will now use the TANDBERG form for all Calendar actions and have the TANDBERG tab 
available when creating new booking requests. 

Because Outlook security does not allow previewing of custom forms, when using the Reading 
Pane in Outlook, calendar events can not be previewed if the entry was created using the 
TANDBERG form.  Users must open the item to view it.   
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Uninstall/Modify/Repair Installation 
Uninstall 
To uninstall the product, select Uninstall TANDBERG Conferencing eXtensions for Microsoft 
Exchange from the product’s group in the start menu on the Exchange Server or use Add/Remove 
programs from the Control Panel of the server. 
Confirm that you want to uninstall the product from the window that is displayed and the product will 
uninstall itself. 
The program will leave its log directory, registry keys, and associated accounts in place to 
accommodate future installations or upgrades. 

Complete Removal of Product 
If an administrator wishes to remove all elements of the installation, the following additional steps may 
be performed after uninstalling the product.  
! Delete the Installation Directory and Logs Directory. 

(Default: C:\Program Files\TANDBERG\Conferencing eXtensions for Microsoft 
Exchange\logs) 

! Delete the Registry key at:  
HKEY_LOCAL_MACHINE\SOFTWARE\TANDBERG\TANDBERG Management Suite Exchange 
Integration 

! Delete the TMS-Service user from Active Directory and it’s associated mailbox 
! Delete the tmsconfuser user account from the Windows Server hosting TMS and the user 

profile in TMS. 
! Delete any resource accounts and their mailboxes as desired.  Existing accounts can continue 

to be used for Exchange-Only booking if desired. 

Note: Due to Active Directory replication, a new installation of TCX should never be attempted 
immediately after removing or modifying service or resource accounts.  Sufficient time must be 
given to allow Active Directory replication to complete before attempting to install TCX again. 

Modify 
Given the standard options of the Installation software, it is possible to select Modify as an option if 
the setup file is opened again after the product is installed.  However, since there are no options to 
install only individual elements of the product, this choice does not allow you to make any changes to 
the product. 

Repair 
If a problem is suspected with the server software itself, a repair is possible. The repair process will 
copy all needed files to the server ensuring all files are correct and in the proper location. 
To repair the installation, start the original TCX setup file on the server if available.  If not, the TCX 
installer is located on the TMS installation media.  Open the index page using browse.bat and click 
the link to Install TANDBERG Conferencing eXtensions for Microsoft Exchange to start the 
installation program. 

Note:  There are separate installers for 64bit installations and 32bit installations – Please use 
the appropriate link for your server type. 
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Click Next, and from the option menu, select Repair. 

 

Click Next and step through the wizard to complete the repair process.  After the repair is done, the 
Configuration Utility will start automatically. 
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Notes for Upgrading from the TANDBERG 
Microsoft Exchange Integration Product 
The TCX product supersedes the previous TANDBERG Microsoft Exchange Integration product.  
Starting with TCX v2 software, TCX can also be used as an upgrade for existing Exchange 2003 
installations. 
There are some differences in how the TCX product operates compared to the previous product and 
this section will outline the necessary additional information for administrators to complete an upgrade 
and highlight differences in operation and user interaction so they can plan their upgrades 
accordingly. 
If you are also changing the version of Exchange Server you are installing onto (from Exchange 2003 
to an Exchange 2007) please jump to the Upgrading to TCX and Migrating to Exchange 2007 
section. 

Upgrading to TCX on Exchange 2003 
Installation Changes/Requirements 
If operating in a segregated AD and Exchange admin organization, do not rely on previous versions of 
the Installation Alternatives documentation for Microsoft Integration in regards to the TCX product.  
This information is now integrated into this manual and you should reference the Appendixes for 
details regarding using TCX in this type of environment. 
Prior to installing the TCX product, you must uninstall the existing TANDBERG Microsoft Integration 
product.  Open the Add/Remove Programs control panel, find the TANDBERG Integration product, 
and click Remove to start the uninstall process.  

Once the uninstall is complete, you may be prompted to restart the server.  If you wish to avoid 
this restart, you can manually stop all Integration components before starting the Uninstall 
process.  Ensure the Configuration Tool is not running.  Then using Microsoft Management 
Console (MMC) stop the TANDBERG Synchronizer Windows Service under Services, and 
using the Component Services Snap-in, expand the Local Computer, and shutdown the 
‘TANDBERG’ COM+ Application by right-clicking on it and selecting shutdown.  With these 
elements stopped, you should not be prompted to restart the server when the Uninstall is 
complete. 

 

Note: During the uninstall process you will have the option to ‘remove all users, groups, and 
settings’.  TANDBERG recommends you do NOT use this option when performing an upgrade.  
If you chose to use the remove option, TANDBERG recommends you wait 24hrs before 
attempting to perform the TCX installation to allow the mailbox and Active Directory changes to 
fully propagate. 

Once the uninstall is complete, you may be prompted to restart the Server.   If necessary, restart the 
server. 
You can now follow the standard TCX installation instructions with the following exceptions: 
! The existing Exchange Service user will automatically be detected and re-used.  The 

administrator will be given the standard choices to reset the password or supply a new one.  
For the TMS-side service account, when prompted, use the Let the installer create a service 
account if needed option.  This will cause the service user on the TMS server to be reused, and 
have its password and Service flag in TMS reset as part of the installation. 

! In the Configure Service Account on the TMS Server step, be sure to select Let the installer 
create a service user if needed.  The installer will detect the previously used tmsconfuser 
account on the TMS server and re-initialize it for the new installation. 

! The first time the Configuration Utility is opened, the utility will detect problems with the existing 
resource accounts.  This is normal as the sinks were disabled when the previous product was 
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uninstalled.  The configuration tool can automatically update the accounts as needed; simply 
select Yes when prompted to correct the issues with the accounts. 

The remainder of the upgrade to TCX is completed by following the normal TCX installation steps.  
Your previously configured resource accounts will carry over to the new installation automatically.   
Note the following details regarding the installer and initial configuration:   
! Your previously configured resources accounts will appear in the right column as integrated 

with Exchange automatically and require no further configuration. 
! The installer will re-use the previously defined Log directory for diagnostics logging.  Post 

installation you should update this to point to the new product’s installation folder or another of 
your choosing.   Changing the log directory is done using the Configuration Utility under the 
Configuration tab. 

! The TCX product no longer creates an Address List for integrated systems.  This address list 
was always optional and could be removed post-installation.  Address lists can still be created 
by the Exchange Administrator if desired to list all integrated systems by using filters. 

! If the TANDBERG supplied custom form was used previously, it should be updated with the 
most recent form.  Be sure to complete the Publishing the TANDBERG Form section of the 
installation instructions to ensure your users have the most recent version of the form. 

Configuration Tool Changes 
The view and layout of the configuration tool has changed compared to the previous product, but the 
fundamentals concepts required to add/remove/test resource accounts have not changed.  The tool 
has a new layout using Tabs that replaces the previous used Advanced button.  Please see the 
Configuration Tool Reference for details on all of the features and use of the utility. 

User Booking/User Experience Changes 
The basic booking principles used by end-users have not changed from the previous product.  Users 
should be able to immediately use scheduling with the new product with no need for retraining or 
additional assistance.  The new TANDBERG form may have additional options compared to previous 
forms, but its overall use is unchanged.  Please see the End-User Interface Reference section 
regarding End-user operation. 

Upgrading to TCX and Migrating to Exchange 2007 
If operating in a segregated AD and Exchange admin organization, do not rely on previous versions of 
the Installation Alternatives documentation for Microsoft Integration in regards to the TCX product.  
This information is now integrated into this manual and you should reference the Appendixes for 
details regarding using TCX in this type of environment. 
Since Exchange 2007 is not installed in-place over an existing Exchange 2003 server, these 
instructions assume you will install TCX on a different Exchange server then what was used 
previously.  Migration of an organization from Exchange 2003 to 2007 is out of the scope of this 
document and will only cover moving the Integration product. 
Due to changes in the resource booking models in Exchange 2007 vs. previous versions, the 
Asynchronous Booking model is the default, recommended booking model for Exchange 2007 
installations.  The instructions and notes below are written assuming you will be using Asynchronous 
Booking.  Please see the Explanation of Resource Booking Models section for further details or 
notes on using Direct Resource Booking. 
Prior to installing the TCX product, you must uninstall the existing TANDBERG Microsoft Integration 
product.  On the existing server, open the Add/Remove Programs control panel, find the TANDBERG 
Integration product, and click Remove to start the uninstall process.  

Once the uninstall is complete, you may be prompted to restart the server.  If you wish to avoid 
this restart, you can manually stop all Integration components before starting the Uninstall 
process.  Ensure the Configuration Tool is not running.  Then using Microsoft Management 
Console (MMC) stop the TANDBERG Synchronizer Windows Service under Services, and 
using the Component Services Snap-in, expand the Local Computer, and shutdown the 
‘TANDBERG’ COM+ Application by right-clicking on it and selecting shutdown.    With these 
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elements stopped, you should not be prompted to restart the server when the Uninstall is 
complete. 

 

Note: During the uninstall process, you will have the option to ‘remove all users, groups, and 
settings’.  TANDBERG recommends you do NOT use this option when performing an upgrade.  
If you chose to use the remove option, TANDBERG recommends you wait 24hrs before 
attempting to perform the TCX installation to allow the mailbox and Active Directory changes to 
fully propagate. 

Once the uninstall is complete, you may be prompted to restart the Server.   If necessary, restart the 
server. 
To reuse the existing resource accounts, the accounts’ mailboxes must be moved to a database on 
the new target Exchange 2007 Server. 
! Use the Exchange Management Console or shell to move the mailboxes.  See this Microsoft 

article for assistance on moving mailboxes for Exchange 2007  
 
Example: Using Exchange Management Shell to move a single mailbox. 
Move-Mailbox contoso\john -TargetDatabase TargetDatabase "First Storage 
Group\Mailbox Database" -SourceMailboxCleanupOptions DeleteSourceMailbox 

 
! Next the mailboxes must be converted to the Exchange 2007 version of a Resource mailbox.  

Example using the Exchange Management Shell: 
set-Mailbox -Identity:ResourceName -Type:Room 

! Be sure the Active Directory user accounts for the resource accounts are in the same domain 
as the Exchange Server where TCX will be installed. 

! For security purposes, you may disable the Active Directory login for each resource account if 
desired.  Using the AD Users and Computers snap-in, set each resource account to Disabled. 

You can now follow the standard TCX installation instructions with the following exceptions: 
! The existing Exchange Service user will automatically be detected and re-used.  The 

administrator will be given the standard choices to reset the password or supply a new one.  
For the TMS-side service account, when prompted, use the Let the installer create a service 
account if needed option.  This will cause the service user on the TMS server to be reused, and 
have its password and Service flag in TMS reset as part of the installation. 

! In the Configure Service Account on the TMS Server step, be sure to select Let the installer 
create a service user if needed.  The installer will detect the previously used tmsconfuser 
account on the TMS server and re-initialize it for the new installation. 

! After installing TCX, the first time the Configuration Tool is opened, the tool will detect problems 
with the existing resource accounts.  This is normal as the sinks were disabled when the 
previous product was uninstalled.  The configuration tool can automatically update the accounts 
as needed; simply select Yes when prompted to correct the accounts. 

The remainder of the upgrade to TCX is completed by following the normal TCX installation steps.  
Your previously configured resource accounts will carry over to the new installation automatically.   
Note the following details regarding the installer and initial configuration:   
! Your previously configured resources accounts will appear in the right column as integrated 

with Exchange automatically and require no further configuration. 
! The TCX product no longer creates an Address List for integrated systems like the previous 

product.  This address list was always optional and could be removed post-installation.  
Exchange 2007 by default has an ‘All Rooms’ address list and additional lists can also be 
created by the administrator. 

! If the TANDBERG supplied custom form was used previously, it should be updated with the 
most recent form.  Be sure to complete the Publishing the TANDBERG Form section of the 
installation instructions to ensure your users have the most recent version of the form. 
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! When using Asynchronous Booking (recommended), calendar permissions are no longer 
required to book a system, so the security groups used by the previous product are no longer 
required.  Access to booking rooms is controlled by the settings defined on the resource’s 
mailbox and calendar.  The existing security groups can be removed, or may be re-used if you 
wish to allow users to be able to open the calendars of resources automatically.  Be sure to set 
the groups on the Resource Defaults tab in the Configuration Utility if you plan on reusing the 
groups. 

Configuration Tool Changes 
The view and layout of the configuration tool has changed compared to the previous product, but the 
fundamentals concepts required to add/remove/test resource accounts have not changed.  The 
following changes are noteworthy: 
! The tool has a new layout using Tabs that replaces the previous used Advanced button. 
! At this time, the Configuration Utility does not display the last received email notification like the 

previous product.   
! When creating Resource Accounts, the utility no longer sets a password on newly created 

Active Directory accounts and the accounts are set to ‘disabled’ in Active Directory. 
! Resource Calendar Permissions Groups are now optional and empty by default.  If added, 

users in these groups will be given permissions to newly created resource account’s calendars 
which allows the user to open the Calendar directly in their own client. 

! Choosing to enable asynchronous booking is no longer available.  Asynchronous Booking is 
the default in the Exchange 2007 resource model and is the preferred model over direct 
resource booking. 

See the Configuration Tool Reference for details on all of the features and use of the utility. 

User Booking/User Experience Changes 
The basic booking principles used by end-users have not changed from the previous product except 
how meetings are saved.  The new TANDBERG form may have additional options compared to 
previous forms, but its overall use is unchanged.   
If the Direct Resource Booking model was used before, users would get a pop-up if their meeting was 
successfully booked and if the booking failed, they could not save their meeting request.  With the 
Asynchronous Booking model, the users will immediately be allowed to save the meeting, and shortly 
after will receive a meeting accept/reject notice from each resource booked in the meeting.  Please 
see the End-User Interface Reference section regarding End-user operation. 
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End-User Interface Reference 
This section will provide details on how users schedule resources and the features available in the 
TANDBERG custom form. 
Booking meetings in Outlook that include video conferencing resources is done using the same steps 
as booking traditional meeting room/resource.  This commonality allows users too quickly and easily 
pick-up scheduling their video conferences using Outlook.  This section will provide a brief primer on 
the basics of creating meetings using Outlook, followed by details on using the optional TANDBERG 
form.  As the booking process varies slightly if the Integration is using the Direct Resource Booking 
model, creating a new meeting is explained separately for each model. 

Creating a New Meeting Using Outlook (using Direct 
Resource Booking) 
The first step is to create a new meeting invitation.  A new invitation can be started via the New button 
in your toolbar, from the File Menu under File > New or by double-clicking a time-slot in your 
calendar. 
A meeting request is similar to an appointment, except a meeting request includes other people or 
resources besides you. 

 

If you do not see the To: line and button, you have opened an Appointment Request.  Switch to a 
Meeting request by simply clicking the Invite Attendees button in the toolbar. 
Using the drop-down menus, set the Start and End time for your meeting.  If your meeting will be a 
recurring meeting, click the Recurrence button to set the options for the meeting.   
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Click the To: button to invite attendees.   

 

Using the Show Names from the drop-down, you can choose from various Address Books created 
by the administrator to browse through.   
Chose the people you wish to invite to the meeting by selecting their name, and clicking the Required 
or Optional buttons.  Optionally you can type their name into the fields directly. 
To book a room or video system, do the same as above to select a room\system but put them in the 
Resources field.  You can mix and match people and rooms in a meeting request, including multiple 
rooms/systems.   People go into Required or Optional fields, rooms/systems go in the Resources 
field.  There is no need to try to book MCUs or Gateways, as they will be handled automatically by 
TMS.   
Click OK to save the participants and return to the Meeting Request. 
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By clicking on the Scheduling tab, you can view the free/busy information for all of the meeting’s 
invitees 

 

Ensure everyone is free during the requested time period, or adjust the meeting’s start and end times 
as necessary. 
When finished, press the Send button to save the meeting and send out the invitations. 
Outlook will pause here as it attempts to save the meeting in the calendars of the rooms\systems you 
invited.  If successful you will get a pop-up window 

 

Note: It is recommended that you do NOT check the checkbox to hide this message 

This message means the rooms\systems have been successfully booked and the meeting has been 
saved in your calendar.  People you have invited to the meeting have been sent an invite and can 
respond individually to your request. 
Shortly after saving the meeting, you as the meeting organizer will get an email from the TCX 
Integration providing you with the details about your scheduled video meeting, including dialing 
information.  You can copy this information into the meeting details and send out an update to invitees 
if desired.  Conference settings such as bandwidth, encryption, etc will be set using the default 
parameters defined by the Conference Settings in TMS defined by the TMS administrator. 
If for some reason the meeting request is rejected by one of the rooms\systems, the pop-up message 
will not appear, the meeting request will stay open, and you will get an email from the TCX Integration 
providing additional details on why the meeting was rejected.    Make adjustments to your meeting as 
necessary and click Save to try to rebook your meeting and the same saving process will repeat. 
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Creating a New Meeting Using Outlook (using 
Asynchronous Booking) 
The first step is to create a new meeting invitation.  A new invitation can be started via the New button 
in your toolbar, from the File Menu under File > New or by double-clicking a time-slot in your 
calendar. 
A meeting request is similar to an appointment, except a meeting request includes other people or 
resources besides you. 

 

If you do not see the To: line and button, you have opened an Appointment Request.  Switch to a 
Meeting request by simply clicking the Invite Attendees button in the toolbar. 
Using the drop-down menus, set the Start and End time for your meeting.  If your meeting will be a 
recurring meeting, click the Recurrence button to set the options for the meeting.   

© 2009 TANDBERG  Page 46 of 86 



  TANDBERG Conferencing eXtensions for Microsoft Exchange – Administrator Guide 

Click the To: button to invite attendees.   

 

Using the Show Names from the drop-down, you can choose from various Address Books created 
by the administrator to browse through.   
Chose the people you wish to invite to the meeting by selecting their name, and clicking the Required 
or Optional buttons.  Optionally you can type their name into the fields directly. 
To book a room or video system, do the same as adding people to select a room\system but put them 
in the Required field.  You can mix and match people and rooms in a meeting request, including 
multiple rooms/systems.  There is no need to try to book MCUs or Gateways, as they will be handled 
automatically by TMS.   
Click OK to save the participants and return to the Meeting Request. 
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By clicking on the Scheduling tab, you can view the free/busy information for all of the meeting’s 
invitees 

 

Ensure everyone is free during the requested time period, or adjust the meeting’s start and end times 
as necessary. 
When finished, click the Send button to save the meeting and send out the invitations.  The meeting 
event will save into your calendar. 
Shortly after saving the meeting, you should expect to get the meeting accept/reject emails from the 
rooms and people you invited to the meeting.  If a room/system rejects the meeting due to some 
reason with the video conference, you will receive an additional email immediately afterwards from the 
TCX integration providing more details on why the meeting was rejected. 
If the meeting was accepted by the rooms\systems, you as the meeting organizer will get an email 
from the TCX Integration providing you with the details about your scheduled video meeting, including 
dialing information.  You can copy this information into the meeting details and send out an update to 
invitees if desired.  Conference settings such as bandwidth, encryption, etc will be set using the 
default parameters defined by the Conference Settings in TMS defined by the TMS administrator.  
See Editing Meetings for more assistance with sending updates. 

Editing Meetings 
Meetings that have not started yet can be easily changed directly in your Outlook client if you are the 
meeting organizer – attendees can only suggest new times, not edit the entire Outlook meeting. 
To edit a meeting, open the event in your calendar by double-clicking on it. 
If the meeting is part of a recurring series, you will be prompted if you wish to edit just this occurrence, 
or the entire series.  Make your selection and click OK. 
Once open, modify the meeting to your like, including changing the time, adding/removing 
participants, etc.   
When complete, click Send Update to save the meeting and send the changes to the meeting 
participants. 

WARNING: Do not click Save and Close as this will only modify your calendar and will not 
send the changes to the other participants, including the rooms/systems.  Doing so will NOT 
update your video conference booking. 
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Deleting Meetings 
To delete a meeting, find the event in your calendar, right click on it and select Delete from the pop-
up menu. 
If the meeting is part of a recurring series, you will be prompted if you wish to delete this occurrence, 
or the entire series. Make your selection and click Ok. 
Finally you will be prompted to send a cancelation notice or not.   

 

Select Send cancellation and delete meeting and click OK.  Sending a cancelation notice is required 
to ensure the meeting will be deleted from the other participant’s calendars, including the 
rooms\systems. 

Modifying Meetings from TMS 
Meetings booked by a user that include a TMS integrated room\system will automatically be created 
in TMS, and the meeting organizer will be set as the meeting owner in TMS.  The meeting in TMS will 
only show rooms\systems included in the meeting and not any individuals included in the meeting. 
As the meeting owner, or as a user that has permissions to modify other user’s meetings in TMS, a 
user can modify bookings created in Outlook/Exchange directly in TMS.  If a meeting is modified in 
TMS, the meeting owner will receive an email with the updated conference information. 
The rooms\systems integrated with Exchange will have their calendars automatically updated if a 
meeting is updated from TMS.  However, for security protections, TMS and the TCX integration do not 
have access to open or modify user’s calendars.  This means a meeting modified in TMS will not 
automatically update the existing calendar entry in user’s calendars. 
If a meeting is updated in TMS, the meeting organizer should update the calendar entry in their 
calendar and send out updates to ensure their calendar and their invited participants are up to date.  
This is also a convenient time to add the updated video conference information to the meeting’s 
details.  

Using the Resource’s Calendar Directly 
Users who have been granted permissions to a resource’s calendar, such as through the security 
groups defined in the Configuration Utility, or directly, have the ability to open the resource’s calendar 
in their own Outlook client.  Opening the calendar is often useful for getting an overview of a 
resource’s activities.  Creating, editing, and deleting meetings directly in the calendar is possible and 
compatible with the TCX integration. 
Users should take care when editing or deleting calendar entries directly in a resource’s calendar 
when a meeting includes a mix of people and resources.  This is because in Outlook Calendaring, 
changes made in the calendar directly will not update the Outlook calendars of other users who may 
be part of the meeting.  Any resources included in the meeting will be updated as the TMS meeting is 
also updated with any changes, but user’s calendars are never touched by the Integration.  Be sure 
the meeting organizer can send updated information out to attendees. 
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Using the TANDBERG Form 
When using the standard Outlook Appointment forms, meetings created using Outlook will be booked 
in TMS using the conferencing defaults defined by the administrator.  Conference settings such as 
such as bandwidth, encryption, call setup type, etc will use the default values defined in TMS.  TMS’s 
call routing logic will automatically handle assigning MCUs, protocols, and gateways as required.  This 
frees users from having to worry about technical details. 
If the administrator has made it available, the TANDBERG custom form replaces the standard Outlook 
Appointment form and adds a new TANDBERG tab to the meeting entry.  This tab allows additional 
functionality beyond the standard form including the ability to override the conference defaults and 
invite external video or audio participants to the conference. 

 

Using the form simply requires selecting the TANDBERG tab in the calendar entry and making any 
changes desired.  Any values left at ‘default’ will use the default setting as defined in TMS by the 
administrator.  Once all changes are made, the meeting can be saved as normal.  Additionally, an 
existing meeting can be edited with changes on the TANDBERG tab using the standard methods.  Be 
sure to use the Send Updates button when saving changes to an existing meeting. 

Description of Form Fields 
A brief description of each setting in the form is listed below.  For further information on topics 
discussed here such as bandwidth, Picture Mode, etc, please see the TMS documentation. 

SETTING DESCRIPTION 

Quality  The bandwidth to use for the conference.  Leaving it at default allows TMS to 
use the default settings for ISDN, IP, and Telepresence calls. 

Picture Mode  Sets the video layout to use for a multipoint conference 

Reservation Type  Sets if the meeting will be a reservation only (only the rooms are reserved), 
manual connect, or automatic connection of the video conference 

Secure Conference  Sets the required encryption level of the conference.  Setting yes requires all 
participants support encryption to book or connect the conference 
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SETTING DESCRIPTION 

Display Option…  Sets if TMS will prompt the Video Conference Master of the conference to 
extend the meeting when the meeting is about to end 

Web Conference  Sets if you would like to request a Web Conference (such as See&Share) 
with the meeting.  If set to ‘Yes’, the meeting will only be booked if a web 
conference reservation could be included.  If set to ‘If possible’ the meeting 
will try to include a web conference, but will be booked even if a web 
conference reservation could not be done.  

Billing Code  You can supply a billing code for the conference that will be saved with the 
meeting in TMS (can be set in TMS to be required). 

Password When using a MCU that can support conference passwords, defining a 
password here will require dial-in conference participants to enter this 
password to join the conference. 

Restrict ISDN Sets 56k Restricted on ISDN calls if checked 

Notes A free text area where notes about the conference can be added and can be 
seen in TMS.  If the booked videosystems are linked up with a contact 
person who receives emails when a system is booked, the person will also 
get this message. 

Add External Use this button to add video or audio participants to the TMS booking that 
are not listed in Exchange.  Such as dialing out to a telephone, or video 
system, or adding Dial-in ports for people to dial into your conference.  
Clicking the Add External button will display a panel where you can define 
the values you wish to use for the participant. 
Click on the Dial-In or Dial-Out tab for the type of participant you wish to 
add.  Enter the values appropriate for the type of participant you are adding 
and click the Add button.  The participant will appear in the External 
Participant list.  Repeat for each participant you wish to add to the meeting. 

 
You can also delete selected dial-in or dial-out participants by selecting them 
and pressing the Delete Selection button. 
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Frequent Asked Questions regarding Outlook 
Booking 
Q: Can I book a meeting using the integrated rooms and not include a video call? 
A: Yes, any meeting created that only has one room\system included will automatically be booked as 
a ‘Reservation Only’ booking.  Additionally, if multiple rooms are booked, a meeting can be forced to 
be a ‘Reservation Only’ booking using the TANDBERG tab and setting Reservation Type to 
‘Reservation Only’ 
 
Q: Why do I not see any MCUs in my Outlook lists? 
A: Booking of a MCU is handled automatically by TMS based on the number and type of participants 
requested in the conference. 
 
Q: Can I book a meeting that only has dial-in participants from Outlook? 
A: For a meeting request in Exchange to create a TMS conference, at least one integrated 
room\system must be included in the meeting.  Trying to book a meeting that has external participants 
defined in the TANDBERG tab, but no resource accounts included in the meeting will not create a 
TMS meeting.  Ensure at least one integrated room\system is included if you wish to schedule a video 
or audio conference. 
 
Q: Can I book just a web conference from Outlook? 
A: A: For a meeting request in Exchange to create a TMS conference, at least one integrated 
room\system must be included in the meeting.  Trying to book a meeting that has Web Conference 
set to Yes in the TANDBERG tab, but no resource accounts included in the meeting will not create a 
TMS meeting.  Ensure at least one integrated room\system is included if you wish to schedule a web 
conference. 
 
Q: Can I book a recording from Outlook? 
A: Yes, you can book a recording device such as the TANDBERG TCS if the system has been 
integrated with Exchange.  The TCS will appear like another room and should be scheduled like any 
other room.  If you need to customize the booking with specific recording aliases, you should create 
the meeting in TMS instead of Outlook. 
 
Q: Can I book meetings using Outlook Web Access? (OWA) 
A: If your administrator and installation allow Asynchronous booking, you can create bookings 
including integrated rooms\systems using OWA.  Direct Resource Booking and the TANDBERG 
custom form are not supported by OWA. 
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TCX Software Reference Guide 
Configuration Tool Reference 
This section will provide details on each of the features and uses of the Configuration Utility.  The 
Configuration Utility can be found in the Start Menu under TANDBERG > TANDBERG Conferencing 
eXtensions for Microsoft Exchange > TANDBERG Configuration 

Initialization Testing 
When the Configuration Tool is launched, it will perform a series of tests on the components of the 
integration and the accounts it discovers as integrated with TMS.   

 

These tests are diagnostics tests to detect any changes to the resource accounts, server, or service 
accounts that may adversely affect the integration.  These tests can catch most administrator induced 
errors.  The number of account integrated will affect the duration of these tests – a progress bar is 
displayed to show percentage of completion. 
Marking the Copy log to Clipboard checkbox will copy the all the text displayed to the clipboard for 
pasting into another application if desired. 
If any errors are detected that the utility can self-repair, a pop-up window will be displayed explaining 
the error and prompting if the error should be repaired.  The utility will report if it was able to fix the 
condition successfully. 

© 2009 TANDBERG  Page 54 of 86 



  TANDBERG Conferencing eXtensions for Microsoft Exchange – Administrator Guide 

Operations Tab 
This is the main page of the Configuration Utility. 

 

Left Column 
The left column displays all systems read from the configured TMS server that the TMS Service 
Account has access to.   Endpoints, Rooms, and Recording Devices are listed – other system types 
are not available for Integration with Exchange but may be included automatically in meetings by TMS 
as required. 
! TMS ID  - Displays the ‘System ID’ from TMS 
! Display Name – Displays the system’s name as displayed in TMS. 
A progress bar and summary is shown at the bottom of the list. 

Right Column 
The right column displays all accounts found that the utility has detected as integrated with, or staged 
to be integrated with the TCX integration.  The utility scans all mailboxes on the local Exchange 
Server and displays all those that have the TANDBERG custom attribute defined in the mailbox. 
! TMS-ID – Displays the System-ID of the TMS system this account is associated with 
! Display Name – Displays the name as read from the ‘Display Name’ attribute of the Active 

Directory account associated with this mailbox 
! AD Account – Displays the DN of the Active Directory account associated with this mailbox  

Tip: The user accounts and mailboxes created to represent TMS systems do not require or 
consume Client Access Licenses (CAL) for your Exchange Server.  CAL licenses are tied to 
users or devices accessing the server, not the mailboxes themselves.  An installation of TCX 
would only need one CAL for the server’s components themselves. 

!"#$%&'("&)*"++,*'
-,))%&.'

-/&01*"&%2,*'
-)$*)34,5)$*)'

6&),.*$),7'
800"9&)5':"9&7'%&'

8!'

-/5),#5';"9&7'%&'
<=-'

© 2009 TANDBERG  Page 55 of 86 



  TANDBERG Conferencing eXtensions for Microsoft Exchange – Administrator Guide 

Adding Systems Button 
The Arrow button between the columns in the Operation tab is used to link systems from TMS to 
resource accounts in Exchange.  Details regarding this functionality are covered in section Enabling 
TMS systems in Exchange. 

Tools/Actions 
Right-clicking on any entry in the right-hand column presents a pop-up menu of available tools and 
actions.  Use the shift or control keys to select multiple entries at once.  These actions are primarily 
used for removing accounts from the integration, troubleshooting, or advanced installation scenarios. 
The list below describes each of the actions available 

ACTION DESCRIPTION 

Enable sink(s) Enables the sinks in the mailbox used to notify TMS about a booking in Exchange. 
When disabling the sinks, no check or booking is done on the TMS server, and the 
booking will only be done in Exchange.  Used for repairing a damaged account or 
for advanced installation scenarios. 

Test sink(s) This tests if the sinks defined in the mailbox are calling the integration components 
with TMS properly. This is done by doing a booking in the past, and verifies that 
TMS replies with an exception informing that the bookings can not be done in the 
past. This can be used to validate bookings from Exchange to TMS are operating 
properly for this account.  This is a troubleshooting-only tool. 

Disable sink(s) Disables the sinks in the mailbox used to notify TMS about a booking in Exchange. 
When disabling the sinks, no check or booking is done on the TMS server, and the 
booking will only be done in Exchange.  Used for troubleshooting purposes. 

Add Calendar 
permissions 

Adds the groups defined in the Resource Defaults page as Editor and Author 
permissions respectively to the Calendar permissions of the selected mailboxes.  
Useful for updating existing accounts if those group settings are updated. 

Add Service User 
Permissions 

Gives the Exchange-side service account (TMS-Service) permissions to the 
mailbox and calendar of the selected account.  Also sets the sinks on the account.  
Used for repairing a damaged account or other troubleshooting. 

Reconfigure 
Account(s) from 
TMS 

Used to fetch updated data from TMS for the selected accounts and update their 
displayed information in Exchange.  This is particularly useful when systems 
change name or numbers in TMS. If this happens, selecting this option will update 
the Active Directory information for the selected accounts.   

Note: Due to Active Directory replication and Address Book generation, it 
may take some time before these changes are seen by Outlook users.   

Remove AD 
User(s) 

Permanently deletes the selected Active Directory account and mailbox from 
Active Directory and Exchange.   

WARNING: This action completely removes the account not only from TCX 
Integration, but from Active Directory as well.   

Note, due to Active Directory replication and Address Book generation, it may take 
some time before these changes are seen by Outlook users. 

Detach from 
Integration 

Removes the selected account from being integrated with TMS by disabling the 
sinks and removing the custom attribute.  Meetings created in Exchange for the 
account will no longer be synchronized with TMS or vise versa.  The account will 
still be visible and usable by Exchange users as a normal Exchange resource 
account.  This would be used to remove an account from Integration, but allow it to 
still be used in Exchange. 
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ACTION DESCRIPTION 

(Re)Book all 
meetings 

This option looks at all future meetings in the resource’s calendar and checks it 
against TMS.  Any meetings not in TMS will be booked in TMS so TMS has the 
correct availability information for the account.  If there is any issue creating a 
particular meeting in TMS, the meeting’s organizer will receive an email describing 
the issue.  This function is typically used when an existing resource in Exchange is 
updated with video support or staged in advanced installs.  This does not replicate 
previously created meetings from the associated system in TMS to the Exchange 
account. 

Current Domain Controller 
This specifies which Domain Controller the Integration and Configuration Utility will communicate with 
for all of its Active Directory needs.  The dropdown list will be populated with all domain controllers 
that it detects for the local domain. 
This selection is available as it allows you to control which domain controller handles the workload of 
all the queries from the Integration and it simplifies troubleshooting of replication as you know where 
the changes are initiated and read. 

Start/Restart/Reactivate Synchronizer 
This button controls the starting of the synchronizer service which is responsible for replicating 
scheduling changes initiated in TMS’s interfaces to the linked accounts in Exchange via a background 
service that runs on the Exchange Server.  If the Synchronizer has not been told to start since 
installed, the button will be labeled Start Synchronizer, and clicking it will tell it to start processing 
scheduling changes in TMS from when TMS was first installed.   
In upgrade scenarios, the Synchronizer will be idle and the button will be labeled Reactivate 
Synchronizer.  Clicking the button will restart the Synchronizer from where it last left off. 
If the Synchronizer has been told to start since installation, the button will be labeled Restart 
Synchronizer.  The Synchronizer keeps track of a transaction history in TMS so that it only has to 
process new changes each time.  Clicking Restart Synchronizer will reset the Integration’s start point 
in that transaction history and begin processing all scheduling changes in TMS from the beginning. 
Restarting the Synchronizer is not needed in normal operation and is only for specific, advanced 
situations.  Restarting the Synchronizer will not affect any meeting data, but is a very intensive 
process that can take many hours to complete. 
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Configuration Tab 
This tab allows you to review and update the communications and configuration elements of the TCX 
Integration that were initially defined during installation.  Changes made here will affect the TCX 
Integration product immediately. 

 

Password for Service User 
The account used as the Exchange side Service user is listed (Default: <domain>\TMS-Service).  If 
you wish to update the password of the Service Account, you must do it via this page.  The 
Configuration Utility will update the Integration’s references to the account’s credentials and the 
password in Active Directory.  Changing the service account’s password outside the utility will cause 
the Integration to fail.  If this occurs, update the account’s password again here using the 
Configuration Utility to restore service. 
To update the password, enter the password in the fields provided and click Apply. 

Rebuild TMS Server Connection 
These fields display the information TCX uses to communicate with the TMS server.  These fields are 
used to update the connection in case any of the values change, such as the service user’s password 
being updated or the TMS server address changing.  To update any of these fields, enter the new 
values and click the Apply button and the new values will automatically be tested.  Each field is 
described below. 
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FIELD DESCRIPTION 

User Name  The username used by the Integration to log into TMS.  The installation created a local 
user account named ‘tmsconfuser’ by default.  The account specified here must have 
TMS booking rights on the systems to be integrated, the Exchange Integration Service 
Account flag enabled in its TMS user profile, and book on behalf permission in TMS.  
The username should be entered with its machinename or domain name as 
appropriate.  Examples:  machinename\username or domain\username 

Password  The password to the specified user account.  Entering a password here will not 
change the password on the account itself, only the password saved to be used by the 
Integration.  To change the password of the service account itself, do so using 
Windows and then enter the password here to update the TCX integration. 

Server  The network address of the TMS server.  If using a load balancer for TMS, enter the 
shared address of TMS. 

Secure 
Connection  

When checked, the integration will use a HTTPS connection when communicating with 
TMS.  HTTPS must be enabled on TMS for this option to be functional.  Please see 
the TANDBERG Document Implementing Secure Management for more information 
regarding HTTPS on the TMS Server. 

Change Log Directory 
This setting controls where the logs for the TANDBERG integration are saved.  To change this setting 
to a new location, enter the folder’s path or click Browse to navigate to the new folder.  Once 
selected, click Apply to save the change. 

Change Sender Address 
These fields define what information is put into the Email Address headers for emails sent by the 
Integration to users.  This is used to change the appearance of emails sent by the Integration to users 
and may be customized if desired.   

Note: The behavior of your email client with regards to headers and from lines may affect what 
users see. 

FIELD DESCRIPTION 

Display Name This field is blank by default, but some mail systems require a value be entered here.

Email 
Address field 

Defaults to the Exchange side Service User’s address (TMS-Service) and is used as 
the From address in the mail header. 

Resource Defaults Tab 
This tab shows several controls available regarding the default configuration of resource accounts 
created by the Configuration Utility. 
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Note: These values are the defaults for accounts to be created.  Changes here do not 
automatically affect accounts that have been created previously 

 

Mailbox Type for new resources (Exchange Server 2007 Only) 
Controls the account type used for new accounts.  The choice does not affect how the integration 
functions and is relevant only to how administrators want to list or display accounts to users in their 
clients. 

Asynchronous Booking (Exchange Server 2003 Only) 
System-wide setting that allows users to use Asynchronous booking in addition to resource booking 
when integrated on an Exchange 2003 server.  If set to Allow, invites sent via email will be processed 
by the Integration.  If set to Instruct user to use resource booking, when an email invitation is 
received, it will be rejected and the user will receive an email instructing them to make the meeting 
request using the Resources field in the meeting invite.  For more information regarding 
Asynchronous booking vs. resource booking, please see Explanation of Resource Booking 
Models. 

Default Organizational Unit 
This setting controls where accounts created by the Configuration Utility will be created in Active 
Directory.  To change this setting, click Browse and a window will appear allowing you to browse the 
Active Directory and specify an existing OU or create a new one. 
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Mailbox Database for New Accounts 
This setting controls which Mailbox storage group is used for mailboxes created for new accounts 
created by the Configuration Utility.  This drop-down list will automatically be populated with all 
Mailbox storage groups found on the local server. 

Resource Calendar Permissions 
The groups defined here will automatically be assigned Editor or Author permissions respectively on 
the calendars of accounts created by the Configuration Utility.  In Exchange 2003 installations, these 
groups are defined during installation, and users must be a member of the Author group to be able to 
use Direct Resource Booking.  Users who are members of the Editor group will be able to book the 
resource and also able to edit meetings in the resource’s calendars that were created by other users. 
In Exchange 2007 installations, these groups are empty by default as the permission groups are not 
used to control booking resource accounts in Asynchronous Booking.  However, they can still be used 
if desired to give user groups direct access to the calendar of resource accounts. 
To change either of these groups, click the Browse button and a window will appear to allow you to 
select a user group from Active Directory. 
If you wish to retroactively apply changes made here to existing accounts, you can use the Set 
Calendar Permissions action in the Operations Tab of the Configuration Utility to apply the security 
groups to selected existing accounts. 

Enabling TMS systems in Exchange 
The left hand column on the Operations tab represents all endpoints, rooms, and recording devices 
found in the configured TMS Server that the TMS side service user has access to.  The right hand 
column lists all Exchange accounts that have been determined to be integrated with TMS via TCX. 
Select one or more TMS systems you wish to enable in Exchange from the left hand list.  Use the shift 
or control keys to select multiple systems.  Click the ! button. 
A new window appears which walks you through the Active Directory configuration for each selected 
system 
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For each selected system, this dialog walks you through creating a new Active Directory account and 
mailbox OR associating the system with an existing Active Directory account and mailbox.  Use the 
Previous/Next button to switch between systems.  The current system being configured is displayed 
in the top left.  The dialog allows you to choose an option for each selected system individually.  
When multiple systems were selected, the OK button will be disabled until a choice has been made 
for each system. 

WARNING:  Account creation/deletion/changes may take time to replicate through your Active 
Directory.  When changes are made outside of the Configuration Utility, depending on your 
Active Directory design these changes may take upwards of an hour to replicate across domain 
controllers.  If you experience errors or inconsistencies with account creation, please shutdown 
the Configuration Utility and allow time for your Active Directory changes to propagate. 

Select the account options for each system as follows 
1. Use the Next/Previous buttons to select the desired system 

ALTERNATIVE A ALTERNATIVE B 

To create a new account for the system: To use an existing account7 

Ensure Create an AD account… is selected.  The 
center panel displays a list view of your Active 
Directory’s organizational structure.  Expand the 
tree if necessary and highlight the Organization 
Unit (OU) where the new account should be 
created.  The mailbox and Active Directory user 
will automatically be created by the utility8.   If 
you wish to use these same setting for the 
remaining accounts to be added, click Create the 
remaining accounts in this folder button, else 
use the Next/Previous buttons to switch to the 
next system.    

This option will reconfigure an existing AD 
user account and mailbox to be associated 
with the TMS system.  Select Use an 
Existing AD Account.  The center panel will 
show you your domain’s organizational 
structure.  Navigate the tree to find the 
desired AD Account or use the Search 
feature.  Only user accounts that have their 
mailbox on the local server will be 
displayed.  Click on the user account you 
wish to associate to this TMS system. 

 

If an OU has more then 1,000 entries, only the first 1,000 will be displayed.  Please use the 
Search option when OUs are very large. 

2. Repeat the above steps using the Next/Previous buttons to toggle between the systems until a 
choice has been made for each system. 

3. Click the OK button to continue. 
In Exchange Server 2003 Installations, the utility will ask you for a password to use for the newly 
created accounts9.  The password entered will be used for accounts that are to be created.  Marking 
the Reset password for all… checkbox will set the password on accounts that are being re-used as 
well.  

The password for resource accounts is not needed by users or in normal use.  It is only for 
administrators that may wish to log into the account/mailbox directly.  The resource account 

                                                      
7 The Active Directory User Account associated with the mailbox must be a member of the local domain where 
the TCX product is installed 
8 The account will be created with the username of TMS-<id> where <Id> is the TMS System ID.  The display 
name of the AD user will be set to the System Name in TMS.  The mailbox will be created in the Mail Store 
designated during installation. 
9 This is only for Exchange Server 2003 Installations – Exchange Server 2007 installations will create an AD 
account with no password and the user account will be disabled as is normal for resource accounts in Exchange 
2007 
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passwords can be changed using standard AD tools afterwards without affecting the TCX 
integration. 

 

Review selections - After choices have been made for all selected systems, a window will present a 
summary display of your choices. 

 

If the information is correct, click OK, or if alterations are needed click the Edit button to return to the 
previous screen. 

If one or more of the systems imported were associated with existing accounts, you will be asked if 
existing meetings events from the accounts’ Calendars should be imported into TMS.  This ensures 
the resources’ calendars and TMS are in synch.  
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Clicking Yes will cause all existing bookings in the Resources’ calendars to be booked in TMS.  
Clicking No will skip this step.  If there are any issues booking an existing meeting, the meeting’s 
organizer will receive an email detailing any actions necessary. 

Meetings with no end date can not be booked in TMS and will synchronize to TMS.  After TCX 
is installed, any meetings of this type should be edited using Outlook to a new meeting with a 
fixed end-date. 

The configuration tool will now perform the tasks as instructed, and a status screen shows the 
progress of the individual systems and the overall progress. 

 

Note: This process can take some time depending on the number of systems you are importing 
and design of your Active Directory. 

When complete, click the OK button and the Operations tab will be displayed with the newly added 
systems in the right-hand column. 

Manually Enabling Auto-Accept 
As part of the process when enabling resource accounts in Exchange 2003, the configuration tool will 
turn on auto-accept in the resource’s calendar options.  In some scenarios, the methods used by the 
software to enable this setting are not available and this must be done manually when resource 
accounts are enabled.  The Configuration Tool will report if it was not able to enable this setting 
automatically when enabling accounts. 
1. On a client computer with Outlook installed, create a new Mail profile using the Mail Control 

Panel.  In the Mail profile, click Show Profiles, and add a new Mail profile, with an Exchange 
Mailbox with the credentials and properties of the resource account you are trying to modify.  
Once created, you can set Outlook to prompt you for which profile to use when launching 
Outlook. 
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2. Open Outlook, and select the profile you configured for the resource account and supply the 
credentials for the resource account. 

3. Once the mailbox opens, select from the menu Tools > Options. 
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4. In the Preferences tab, click the Calendar Options button. 

 

5. In Calendar Options, click the Resource Scheduling button. 

 

6. Mark the checkbox for Automatically accept meeting request and process cancellations and 
click OK 

7. If you are prompted about setting default permissions, accept the change 
8. Click OK to close the Calendar Options, and click OK again to close the Options panel.  Close 

Outlook 
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TCX Logging Features 
The TCX product has logging features to assist with troubleshooting of the installation and operation if 
required.  The directory for these log files is configured in the Configuration Utility and by default is a 
sub-folder named Logs in the installation directory. 
The logging detail and modes are controlled via registry settings the administrator can modify if 
desired.  All values are stored in the registry at 
HKEY_LOCAL_MACHINE\SOFTWARE\Tandberg\TANDBERG Management Suite Exchange Integration   

Administrators can use the Windows Registry Editor to create/modify the registry keys as needed. 
After any of these registry settings have been modified, the Integration should be restarted to have 
the changes take effect.  This can be done by either restarting the Windows Server, or you can avoid 
restarting the server by restarting the TANDBERG COM+ Package itself. 
To restart the COM+ Package, 
1. Open the Component Services Snap-in in a MMC Console 
2. Expand the tree Component Services > Computers > My Computer > COM+ Applications 
3. Find the TANDBERG listing, right-click on it and select Shut Down 
4. Right-click on the TANDBERG listing again, and select Start 
The TANDBERG components will not process any registry key changes you may have made. 

Setting Log Levels 
Logging is controlled per component.  You can define the level of information logged, and where it is 
logged to.  By default, Errors and Info are logged to file for all components.  Changing this behavior is 
controlled through the creation of two possible registry strings for each component - LogLevel and 
LogMode.  These keys are not present by default, and if not detected, the default values are used. 
A list of valid components you can control are listed below.  The name in the left column is the string 
to use in the registry string (names are case sensitive!) 

VALID COMPONENTS HOW TO USE 

Installation Logging for steps and actions from the software 
installation/upgrade/uninstall 

TANDBERG Configuration Logging for actions initiated from the Configuration Utility 

TANDBERGSinks Logging related to the mailboxes/calendars and triggering of the 
Synchronizer 

SyncHandler Logging related to the Synchronization processes between TMS and 
Exchange 

TMSConferenceAPI Logging related to the conferencing details passed between TMS and 
Exchange  

 

LogLevel 
The Loglevel value is used for controlling the amount of detail that is logged for a particular 
component.  To set the LogLevel for a particular component, create a new String Value in the TCX 
registry key whose name is LogLevel ComponentName replacing ComponentName with one of the 
valid Component names.  Once created, modify the string by double-clicking it and set the value to 
the desired level from the list below. 
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VALUE MEANING 

-2 Off 

-1 Errors Only 

0 Errors and Info (default) 

1023 Full debugging 

 
LogMode 
The LogMode value defines where the information for a particular component is logged to.  Logging 
can be to file or to OutputDebugString.  When logging to OutputDebugString, you can use the freely 
downloadable DebugView utility from Microsoft to capture and view the information in real-time.  
DebugView can be found at 
http://www.microsoft.com/technet/sysinternals/Miscellaneous/DebugView.mspx 
To set the LogMode for a particular component, create a new String Value in the TCX registry key 
whose name is LogMode ComponentName replacing ComponentName with one of the valid 
Component names.  Once created, modify the string by double-clicking it and set the value to the 
desired level from the list below. 

VALUE MEANING 

1 Log to file (default) 

2 Log to OutputDebugString 

 
Example:  Setting component ‘TANDBERG Configuration’ to Debug Level Logging to file 

 

Managing Log Files 
All log files are written to the same directory.  This directory is normally defined using the 
Configuration Utility, and can be seen in the registry key as string Log directory .  When a 
component is set to log to file, each component creates a separate log file named 
ComponentName.log in the log directory. 
To prevent the logs from getting too big and taking up too much disc space, an administrator can 
control the maximum file size and rotation of the log files. This is done globally, so all logs share the 
same rotation and sizing rules.  The size of files is controlled by the string value Log Size 

Log Size 
This registry setting is used to control size. The log size is a string whose value is the maximum size 
of a log files in bytes.  To set the Log Size, create a new String Value in the TCX registry key whose 
name is Log Size .  Once created, modify the string by double-clicking it and set the value to the 
desired size in bytes.  Example, setting the value to ‘10485760’ for 10MB.  This is also the default 
value used if Log Size is not defined. 
The log files will be rotated when a log hits its maximum size as defined by Log Size.  When that 
happens, the log file is renamed ComponentName.bak and a new ComponentName.log file is 
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created.  If an existing ComponentName.bak file already exists, it is replaced by the newly rotated 
log. 

Resolving Custom Attribute Conflicts 
The TCX integration relies on being able to set/read a Custom Attribute 1 in the mailboxes used for its 
Exchange Service account and the resource accounts integrated with TMS.  In some customer 
installations, this custom attribute is already in use for other customer-specific uses.  To 
accommodate these situations, Administrators can define which of the 15 possible custom attribute 
slots the TCX product will use.   
To change from the default perform these steps prior (recommended to do prior to installing TCX) 
1. Open the Registry Editor regedit.exe 
2. Navigate to the registry key   

HKEY_LOCAL_MACHINE\SOFTWARE\Tandberg\TANDBERG Management Suite Exchange 
Integration. 
If it does not exist, create a new registry key in this location. 

3. Select the TANDBERG Management Suite Exchange Integration key, and in the right panel, 
right click and select New > String Value.  Name the new value TMS Id AD Attribute (case 
sensitive!). 

4. Double-click the newly created string value, and in the value field enter the number of the 
attribute you wish to use and click OK. 

5. Close the registry editor. 
When running the TCX installer and Configuration Utility they will now use the custom attribute ID 
defined in the registry key.  This does not reconfigure any existing accounts, so if any existing 
accounts were added before making the change will need to be re-enabled using the Configuration 
Tool to update them with the new settings.  
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Additional Reference Materials for 
Administrators 
The following sections are reference material for Exchange Administrators.  These sections provide 
additional details on the technology behind the TCX integration and the impact on the Exchange 
Server itself so administrators can be confident in how the TCX software affects their environment. 

Functional Overview of TCX Integration 
The calendaring functionality of Microsoft Outlook and Microsoft Exchange allows users to create 
meeting events in their calendars, invite other participants, resources, or equipment directly from their 
Outlook client.  The workflow and steps to book such meetings are commonly understood by Outlook 
users.  TANDBERG Conferencing eXtensions (TCX) leverages the programmable extensibility of 
Microsoft Exchange to expand this functionality to include functionality from TMS while making 
minimal or no changes to the User’s experience.  This reduces training needed to deploy the product 
and makes scheduling of video conference resources easier and more accessible. 
To model rooms or equipment that can be invited to meetings by users, Exchange uses designated 
mailbox and user accounts to represent what users can schedule.  Exchange Server 2007 updates 
this model by having special designations of ‘room’ or ‘equipment’.  These accounts have their own 
calendars and permissions, just like a normal user.  In a traditional installation, these accounts are 
configured to automatically accept all meeting invitations sent to them, and their calendar is updated 
so other users can see when the room is available. 
TMS has its own database which maintains scheduling information and availability for all systems it 
manages.  Beyond availability, TMS also understands notions such as are other resources such as is 
a MCU required?  How to automate any call connections? Are the systems using compatible 
protocols? etc.  Users are able to make requests to book resources managed by TMS directly from 
the TMS web interface. 
To allow users to schedule their TMS managed devices from Outlook or TMS interchangeably, there 
must be a representation of a system/room in both environments.  In TMS, this is the managed 
system.  In Exchange, a resource account is created to represent the system/room. These two 
representations must be kept in synch to allow users in either environment to use them 
interchangeably. 
Because TMS understands more about the resources, and adds additional checks before allowing a 
meeting to be created, TMS is the authoritative role.  Meetings are not allowed to be saved, unless 
TMS says the meeting is valid.  For meetings created directly in TMS, this is done by default and TMS 
does not need to check with Exchange.  For meetings created in Exchange, this means Exchange 
must check with TMS, before allowing a meeting to be saved.   Additionally, there must be a 
synchronization process to ensure any meetings or changes that originate in TMS, are updated on the 
calendars in Exchange. 
To achieve this, two methods are used.  The TCX software interjects when a meeting is attempted to 
be saved in a resource’s Exchange Calendar so it can check with TMS, and a synchronization 
process is used to update Exchange with changes that originate on the TMS side. 
To interject when meetings are saved in Exchange, TCX uses ‘Calendar Sinks’ on the resource 
accounts.  Whenever someone attempts to write to the Calendar, the details are provided to TMS, 
and a meeting is created in TMS based on the details of the Exchange invitation.  If the meeting is 
able to be saved in TMS, the meeting is allowed to be saved in Exchange, and the booking user gets 
an acceptance message followed by an email with the meeting details from TMS.  If the meeting is not 
possible to save in TMS, the meeting in Exchange is rejected and the user receives an email stating 
why.  Sinks allows TCX to inject itself only on resource accounts the administrator intends to be 
integrated with TMS; leaving all other calendars and resources untouched and operating as before. 
Because the sink method only interjects when a meeting is saved on an Exchange Calendar, 
something must update the Exchange Calendars if changes are made to the representation of the 
system/room in TMS.  This process is handled by a synchronizer installed on the Exchange Server 
that is notified whenever a booking change happens on TMS.  The synchronizer connects to TMS to 
determine if the change affects any of the systems integrated in Exchange, and updates their 
calendars as needed.  The synchronizer also automatically checks every 3 minutes as a failsafe in 
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case notifications from TMS are missed.  Using these methods, resource calendars are updated 
almost immediately after changes have been made in TMS. 
The combination of interjecting when writing to the calendars of resource accounts and Synchronizing 
keep the separate representations of the same room or system in synch across both platforms. 

Changes and Impact of TCX Installation on Existing 
Servers 
This section is provided as reference for administrators who desire to understand fully the impact of 
installing TCX integration on their Exchange Server. 
As part of the guided installation, the installer makes the some necessary changes in the scope of 
Domain users, the Exchange Server, and TMS Server.  The changes of significance are listed below. 

Changes on Exchange Server and Domain 
! The installing user specifies an Organization Unit (OU) to use as the default location for all 

accounts created by the software.  The user is given a choice to create a new OU if desired. 
! A ‘TMS-Service’ Active Directory user account is created in the local domain in the selected OU 

to act as a service account on the Exchange Server 
! A strong password is automatically created for the user.  This can be changed using the 

Configuration Utility post-installation if needed. 
! A mailbox is created for TMS-Service account and an inbox sink is registered on the 

mailbox 
! There is an option to re-use an existing AD user account if desired instead of creating a 

new one if desired 
! Creates two security groups which are used to assign calendar permissions (Only created in 

Exchange 2003 installations) 
! A role-restricted COM+ Application is created on the Exchange Server which runs as the TMS-

Service service account 
! An installation folder with a log directory is created and the service user is granted access to 

the log directory 
! A Configuration Utility is installed to manage the product, and is accessible via a TANDBERG 

Program Group added to the Start Menu 
! Registry keys are created within a TANDBERG Hive in the Registry and the service user is 

granted permission to these keys 

Changes on TMS Server 
! A local Windows User account named ‘tmsconfuser’ is created on the TMS Server (Normal 

Windows User privileges only) with a strong random password. 
! Alternatively an existing account can be specified during installation if manually 

configured 
! Assigns the ‘tmsconfuser’ account the ‘Exchange Integration Account’ permission within TMS 

and adds it to the Site Administrators Group 

Permissions Granted to Service Users 
The service users permissions will be configured automatically when created by the installer, but the 
following permissions must not be restricted for the service users. 
Exchange Side Service User - TMS-service 
! Log on as a Batch job 
! Read/Write permissions to the TANDBERG Key in the registry 
! Write permissions to log files directory 
! Read permissions to log files directory and the installation directory 
! Activate permissions to the TANDBERG COM+ package 
! Do not grant this user any Exchange Administrator Roles to prevent it from accessing other 

mailboxes 
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TMS Side Service User - tmsconfuser 
! Must have access to login to the Windows Server hosting TMS 
! Needs to be a member that has ‘Book on behalf of’ permissions in TMS 
! Must have ‘Exchange Integration Service Account’ set to Yes in it’s TMS Profile 
! Must have booking permission to the systems in TMS to be integrated 

Licensing Requirements 
Exchange Licensing 
The TCX Integration has no impact on your Exchange licenses from Microsoft. 

TMS Licensing 
Each system that is to be integrated with Exchange must already exist in TMS and be properly 
licensed itself in TMS.  For licensing of TCX Integration, the licensing can be per system, or per 
Exchange Server integrated with TMS depending on the type of license you purchase. 
When using per system licensing, controlling which systems are consuming licenses is set by the 
Remote Booking flag in System Navigator on each system.  By default, Remote Booking will be set 
to No for each system.  The first time a system is used from Exchange, if there is a free license 
available on the TMS server, Remote Booking will be toggled to Yes for that system.  In doing so, 
licensing is automatically enabled for systems you have integrated with Exchange.  If no more 
licenses are available, and Remote Booking = No for that system, the requested booking will be 
denied. 

Explanation of Resource Booking Models 
Microsoft Exchange and Outlook offers two distinct ways to book resource accounts.  The different 
models have different requirements and user experiences.  Both models should be understood so an 
administrator can decide which is best for their organization.  In Exchange 2003 installations, 
administrators may choose which booking model to use.  In Exchange 2007 installations, Microsoft 
has moved away from the Direct Resource Booking model and therefore it is no longer the default 
method and is not covered by the standard instructions in this manual.  Notes on using Direct 
Resource Booking in Exchange 2007 with TCX can be found in the section Using Direct Resource 
Booking in Exchange 2007.. 

Resource Scheduling Model/Asynchronous Booking 
In this model, users send a meeting invitation via e-mail to the resource accounts just like they invite 
other meeting participants.  The meeting invite is then accepted or rejected by the resource account 
and the meeting coordinator receives a response just as they do from other meeting participants.  The 
sending of the invite and receiving of the response are done separately, so this model is referred to as 
‘Asynchronous Booking’ by TANDBERG. 
This model has the advantage that users do not need to have special permissions to the resource’s 
calendar and they are not required to use the Resources field.  This model also does not rely on the 
Outlook client, so it is more compatible with other interfaces, such as Outlook Web Access (OWA).   
In this model, the user sends out invitations before they receive a confirmation from the resource 
accounts.  This means if a resource rejects the initial meeting invite, the user should re-open the 
calendar entry and try to rebook it.  In an Exchange-Only installation, there is less potential for a 
resource account to reject a meeting as long as it is free.  But when scheduling audio/video resources 
in addition to room availability, there can be other reasons such as a lack of MCUs available, 
incompatible call types, etc that could lead to a request being rejected.  With Asynchronous Booking, 
users have more flexibility, but they also must take care to not repeatedly try to re-book a meeting to 
avoid annoying other users with too many meeting updates. 
Asynchronous Booking is available in both Exchange 2003 and Exchange 2007 installations of the 
TCX Integration.  On Exchange 2007 installations, it is the default and can not be disabled.  On 
Exchange 2003 installations, the integration can be configured to allow or deny Asynchronous 
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requests.  On Exchange 2003 installations, a TANDBERG provided inbox sink facilitates 
Asynchronous requests.  In Exchange 2007, the Resource Attendant provides this functionality, and is 
configurable using the Exchange Management Shell. 

Direct Resource Booking/Synchronous Booking 
In this model, when creating a meeting, users put the resource accounts for the meeting in the 
Resources field of the meeting invitation.  By doing so, the Outlook client tries to save the meeting in 
the resource’s calendar directly before the meeting is allowed to be saved by the user.  The benefit to 
this is the user gets immediate feedback if the meeting can be saved in the resource accounts 
calendars and avoids needing to edit a meeting after it is saved due to a later rejection.  In this model, 
the user must use the Resources field in the meeting invitation for resources, and not the Required 
or Optional fields. 
The negatives to this model are that it requires specific calendar permissions and settings to operate.  
The TCX Configuration Utility automates those tasks when enabling resource accounts, minimizing 
that burden. 
In the previous product, Direct Resource Booking was the default booking model as it offers greater 
controls over who can book which resource and for the user feedback.  When TCX is installed on an 
Exchange 2003 server, this model is still the default choice. 
Exchange Server 2007 changed the booking models available, and Direct Resource Booking is no 
longer the preferred booking model in Exchange.  The new policy controls and Resource Booking 
Attendant have enabled new features and better manageability.  As such, with Exchange 2007 
installations and going forward, Direct Resource Booking is no longer the default, and no choice is 
given to disable e-mail based reservations (Asynchronous Booking). 

Using Direct Resource Booking in Exchange 2007 
It is possible to use Direct Resource Booking with Exchange 2007 but it is not the recommended 
scenario and functionality is reduced compared to Exchange 2003.  This manual is not written to 
describe the combination of Exchange 2007 and Direct Resource Booking.  For those that wish to 
continue to use this model, the additional details below are provided to account for differences in the 
regular manual text as it relates to Direct Resource Booking. 
! You must have Public Folders deployed in your Exchange Organization. 
! When upgrading from Exchange 2003, and reusing existing accounts, do not convert the 

mailboxes to type room or equipment – leave them as user mailboxes. 
! To use Direct Resource Booking, an account must be a user mailbox type, not a room or 

equipment type.  This means you can not use the Configuration Utility to create new mailbox 
accounts.  You may follow the steps in the Appendix for using TCX with Separate Admin roles 
to manually create accounts. 

! The Editor and Author permission groups are not populated by default in Exchange 2007 
installs.  These should be defined and used as they were in Exchange 2003 to properly grant 
users the ability to directly book in an account’s calendar.  Ensure the groups are defined, and 
use the ‘Add Calendar Permissions’ action in the Operations Tab of the Configuration Utility to 
add the permissions to selected accounts. 

! The ‘Enable AutoBooking’ action will not be available in the Configuration Utility.  Follow the 
steps in the section Manually Enabling Auto-Accept to enable Auto-Accept in the calendar of 
newly created resources. 

! Users who incorrectly try to use Email invitations to an account bookable only through Direct 
Resource Booking (a user mailbox instead of a room or equipment mailbox) will not get a reject 
message nor will the meeting be booked. 
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Appendix - Creating the Organization Forms 
Library in Exchange Server 2007 
During the installation of the first Exchange Server 2007 as a new Organization, the setup prompted 
the user with ‘Do you have any client computers running Outlook 2003 and earlier or Entourage in 
your organization?’.  If the user answered yes, a Public Folder database and Organizational Forms 
library was automatically created.  If they answered no, no Public Folders would have been created 
and creating a Public Folder Database is most likely required to be able to publish the TANDBERG 
form. 
If Exchange Server 2007 was installed along side an existing Exchange Server 2003 environment, the 
Public Folder database should have been created and configured to replicate with the existing 2003 
Public Folder database and Organizational Forms Library. 
The steps below cover the basic concepts for setting up Public Folders and an Organizational Forums 
library in Exchange Server 2007.  Due to the high variation in installations, these are not step-by-step 
instructions but rather a collection and guide to the reference material provided by Microsoft regarding 
Public Folders and Organization Forms Libraries in Exchange 2007.  Administrators should reference 
Microsoft’s documentation for more detailed information regarding Public Folders. 

Relevant Microsoft articles: 
Understanding Public Folders - http://technet.microsoft.com/en-us/library/bb397221.aspx 
Understanding Public Folder Replication - http://technet.microsoft.com/en-
us/library/bb629523.aspx 
Managing Public Folders - http://technet.microsoft.com/en-us/library/bb124411.aspx 
How to Create a New Public Folder Database - http://technet.microsoft.com/en-
us/library/bb123687.aspx 
How to View or Configure the Settings of Public Folders - http://technet.microsoft.com/en-
us/library/bb123509.aspx 
How to View or Modify Public Folder Database Settings - http://technet.microsoft.com/en-
us/library/bb124522.aspx 
How to Create an Organizational Forms Library in Exchange 2007 - 
http://technet.microsoft.com/en-us/library/cc540468.aspx 
http://support.microsoft.com/kb/933358 
Configuring Public Folder Permissions - http://technet.microsoft.com/en-us/library/bb310789.aspx 
 

Setting up an Organizational Forms Library 
These steps must be performed by an Exchange Administrator.  See the supporting Microsoft articles 
for specific permissions. 
 
1. On an Exchange Server, open the Public Folder Management Console by opening the 

Exchange Management Console, clicking on Toolbox, and then double-clicking on Public 
Folder Management Console.  If there is an existing Public Folder Database, the console will 
connect to it, and the navigation tree will list both Default Public Folders, and System Public 
Folders.  Public Folder Databases can also been in the Exchange Management Console > 
Server Configuration > Mailbox and viewing each server’s databases. 

2. If no Public Folder Database exists, you will need to create one and mount it.  See How to 
Create a New Public Folder Database - http://technet.microsoft.com/en-
us/library/bb123687.aspx for assistance with creating a new Public Folder Database.  Once 
completed, you should be able to open the Public Folder Management Console, and be able to 
expand System Public Folders and see EFORMS REGISTRY 
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3. Using the Exchange Management Shell, create a new Public Folder named TANDBERG Form 
under EFORMS REGISTRY for the Organizational Forms Library.   
Example: 
New-PublicFolder –Path “\NON_IPM_SUBTREE\EFORMS REGISTRY” –Name “TANDBERG 
Form” 

 
Later steps require the use of the Outlook client and having an active mailbox with specific 
permissions to the Public Folder that was created.  The administrator who created the Public Folder 
by default has sufficient permissions to complete those steps.  However, if that administrator can not 
use an Outlook Client with a valid mailbox, you must grant permissions to the Public Folder for a user 
who can use Outlook.  To grant the required permissions to a user, use the following commands in 
the Exchange Management Shell, substituting in the correct domain\username for the user to be 
granted the permissions. 
 
Add-PublicFolderClientPermission –Identity “\NON_IPM_SUBTREE\EFORMS 
REGISTRY\TANDBERG Form” –User “domain\username” –AccessRights Owner 

Add-PublicFolderAdministrativePermission -Identity “\NON_IPM_SUBTREE\EFORMS 
REGISTRY\TANDBERG Form” –User “domain\username” –AccessRights AllExtendedRights 

 
4. As the Administrator who created the Public Folder, or as a user granted the required 

permissions in the previous step, switch to a computer with Outlook installed with a valid mail 
profile. 

5. Download and extract the MAPI Editor from Microsoft - http://go.microsoft.com/?linkid=5684182 
6. Launch the mfcmapi.exe executable. 
7. From the Session menu, select Logon and Display Store Table.  If prompted, select the 

correct mail profile to use.  The screen will update to show the stores from the user’s profile. 

 

8. Right click the row with the Display Name Public Folders and select Open Store 
9. Expand the tree in the left panel down to the TANDBERG Form folder.  Public Root -> 

NON_IPM_SUBTREE -> EFORMS REGISTRY -> TANDBERG Form 

 

10. In the center panel, scroll through the list and find the entry starting with PR_URL_NAME and 
select it 

http://go.microsoft.com/?linkid=5684182
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11. From the Property Pane menu, select Modify Extra Properties and a new Extra Properties 
window will appear. 

erty Tag button 
 click OK 

itor.  Click Ok again to close the Extra Properties 

st. 
 

e steps using the MAPI Editor, please see How to create an 

12. Click the Add button and the Property Tag Editor Window will appear 
13. Click the Select Prop
14. Scroll through the list and find PR_EFORMS_LOCALE_ID , select it and
15. Click Ok to close the Property Tag Ed

Window 
16. The PR_EFORMS_LOCALE_ID Property will now be listed with a red icon next to it in the 

property li
17. Double-Click PR_EFORMS_LOCALE_ID and in the unsigned decimal field, enter 1033 and

click Ok. 
18. Close the MAPI Editor. 

For Microsoft’s description of th
Organizational Forms Library in Exchange 2007 - http://support.microsoft.com/kb/933358 

This completes the steps necessary to create the Organizational Forms Library.  Administrators 
performing an installation can continue onto the Publishing the TANDBERG Form and Configuring 
clients to use the Form sections of the documentation. 
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APPENDIX - USING TCX INTEGRATION WITH 
REDUNDANT TMS SERVERS 
If your TMS installation includes multiple TMS front-end servers in a redundant or fail-over scenario, 
some additional care must be taken when installing and configuring the TCX Integration.  This section 
will cover any to be aware of to ensure the TCX Integration will continue to work in your redundant or 
fail-over scenario. 

Pre-Installation 
The TMS side service account is normally created by the installer as a local Windows user.  Because 
the TCX Integration should be able to use any of the TMS servers, a domain user account should be 
used instead so the credentials will work on any of the servers. 
1. Create or designate a Domain user account you will use as the TMS side service account.  

Using this account, open a web browser and log into the TMS web interface so a user profile 
will be created for the user.  Once complete, close your browser. 

2. Open a web browser and log into your TMS server with a username that is a Site Administrator.  
Edit the service user’s profile under Administrative Tools >User Administration > Users.   In 
the account’s profile, set Exchange Integration Service Account to Yes.  Set the user’s email 
address to what will be the Exchange Service Account’s email address.  This normally would be 
tms-service@<SMTP Domain>10.  Ensure the user is a member of a TMS group that has the 
Book on behalf permission set in the Group Permissions.  Save the changes to the user’s 
profile and close your web browser. 

Installation 
The normal installation steps can be followed taking note of the following specifics: 
! When prompted to Select the Service Account for TMS, select the option I have created a 

service user on the TMS server and enter the credentials of the Domain user you designated to 
use as the service user.  For the TMS address, be sure to enter the address that is shared by 
your TMS servers (the DNS hostname, or load balanced address, etc).  Do not select the 
HTTPS option unless all servers have been properly configured for HTTPS operation. 

Operation 
There is no change in operation compared to a traditional TMS.  By using the shared or load balanced 
address for the TMS server in the Configuration Utility, the integration will connect to a live TMS 
server the same as regular users do. 

                                                      
10 If unsure of this address, enter any valid email address and you can come back and update the user’s TMS 
profile with the correct address after the TCX Installation has been completed and the TMS-Service account is 
created. 
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APPENDIX - USING TCX INTEGRATION WITH 
EXCHANGE 2007 CLUSTERING 
Overview 
The TCX Integration product has been designed to be compatible with a Clustered Mail Server 
created using the Continuous Cluster Replication (CCR) model of Exchange 2007. 
When an organization uses Exchange Clustering, TCX can always be installed on another Exchange 
Server within the organization that is not part of a cluster.  This is true for both Exchange 2003 and 
2007 installations.  With clustering support, TCX can actually be installed on an Exchange Server that 
is a node of a Clustered Mail Server (CMS) and will fail-over along with the Exchange Service. 
In a CMS setup, TCX is installed on each node in the Exchange Cluster.  The TCX Integration itself 
will not be clustered, and therefore will not show up in the Services/Applications of the Failover 
Management Console.  Instead, the TCX integration on each node follows the state of the Exchange 
Clustered Server and is only active when the local server is the active node in the cluster. 

Clustering Requirements 
Installing on a cluster requires the additional restrictions on the standard TCX requirements 

 DETAILS 

Exchange Server 2007 w/Service Pack 1 ! Must be a CCR Clustered Mail Server 
! Must be Service Pack 1 or greater 

Windows Server 200811 64bit  ! Clustering requires Enterprise or Datacenter Edition
! Recommend a Node and File Share Majority for 

Quorum Model 
! Latest Service pack recommended 

Installation 
These instructions assume your Clustered Mail Server (CMS) is already installed and operational.  
For assistance setting up and configuring your Clustered Mail Server – please refer to the Microsoft 
documentation - http://technet.microsoft.com/en-us/library/bb629714.aspx 
The installation on cluster nodes follows the same general steps as a stand-alone installation of TCX 
with minor differences.  Follow the steps below to perform a first time installation. 
1. Create a Service User Manually - The service user that will be used by TCX on the Exchange 

Server should be created manually rather then allow the Installer to create the account. 
a. Create a new local domain user with a strong password to act as the TMS-Service 

service account.  Example: TMS-Service.  The TMS-Service account should have a 
mailbox created on the storage group hosted by the Clustered Mailbox Server.  The 
TMS-Service account must have a SMTP email address that is reachable from the mail 
server used by TMS. 

2. Add Log on as Batch Job permission – The TMS-Service user needs the Log on as Batch Job 
Local Security Policy setting on each Windows Server in the cluster.   As an administrator, log 
into each server and grant the Log on as Batch Job permission to the TMS-Service user.  See 
http://technet.microsoft.com/en-us/library/cc739028.aspx for assistance on assigning user 
rights. 

3. Add Cluster Permissions – The TMS-Service user needs access to the Cluster so it can check 
the state of the cluster – it will not make any changes to the cluster.  Using the Failover 
Management Console in Windows, right-click on your cluster and select Properties.  Under the 

                                                      
11 Windows 2003 Clusters are not supported due to MS DTC clustering requirement.  Windows 2008 
allows a local MS DTC Instance. 

http://technet.microsoft.com/en-us/library/cc739028.aspx
http://technet.microsoft.com/en-us/library/bb629714.aspx
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Cluster Permissions tab, click Add and select your TMS-Service account.  Grant the TMS-
Service account Full Control.  Click OK to save the changes. 

4. Install on the Active Node – You will perform the complete installation of TCX on the Active 
Node of the cluster as if it were a stand-alone installation following the instructions under the 
Installation and Upgrades section with the following exceptions: 
a. When prompted to specify the Exchange Service User, select I want to use an existing 

domain account and select the TMS-Service account you previously staged.  When 
prompted for the password for the Exchange Service User select the I have the 
password and will provide it below option and enter the password previously created for 
the TMS-Service user.  The installer can not change or reset the Service User’s 
password in Active Directory when in clustered mode. 

b. Note that you can not use replication for a Public Folder database hosted on a CMS 
server.  A Public Folder database can be on the CMS server, or off the CMS server, but 
not both. 

5. Install on Passive Nodes – Once the installation has been complete, you will repeat the 
Software Installation steps only on each of the Passive Nodes.  Follow the instructions in the 
Installation of Server Software section on each of the passive nodes of the cluster with the 
following exceptions 
a. The installer will detect the presence of your existing Exchange Service Account.  When 

prompted for the password for this account, select the I have the password and will 
provide it below option and enter the password previously created for the TMS-Service 
user. 

b. Only perform the Server Software installation, the other steps of installation do not need 
to be repeated. 

c. Any Configuration Utility customizations on the Configuration and Resource Defaults 
tabs must be repeated on each node by running the Configuration Utility on the node and 
updating the settings. 

Upgrades 
To upgrade an existing TCX install on a Clustered Mailbox Server you must run the software 
installation on each of the Cluster Nodes with the following exceptions: 
! Upgrade the Active Node in the Cluster first. 
! Run the software installation steps and when the installer detects the existing Exchange 

Service account, select the I have the password and will provide it below option and enter the 
password previously created for the TMS-Service user.  The installer can not change or reset 
the Service User’s password in Active Directory when in clustered mode. 

! After installing the software on the Active Node, repeat the installation on each of the Passive 
Nodes. 

Uninstalling TCX 
To remove TCX from a Clustered Mailbox Server, you must run the software uninstall instructions on 
each node in the Cluster.  You can follow the standard uninstall instructions in the Uninstall section.  
When running the uninstall on each node, at least one of the nodes must be the CMS active node 
when running the uninstall to complete the uninstall and disable the sinks on resource accounts. 

Operational Changes when using a Clustered Mail 
Server 
! The TCX software automatically follows the state of the Clustered Mail Server and takes no 

interaction from the administrator to ‘fail-over’.  The TCX installation on each node 
independently starts and stops as necessary. 

! The start-up tests ran when the Configuration Utility is opened will show the state of the current 
node, Active or Passive.  You can also see the node state in the Configuration Utility as the 
Synchronizer button on the Operation tab will be disabled when the node is not the active node. 
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! Unlike a stand-alone install where you should update the Exchange Side Service user 
password via the Configuration tool, when in a clustered mode, you must update the password 
in Active Directory first, and then update the TCX installation on each node.  The configuration 
utility can not update the password in Active Directory for the service user, only the locally 
stored value. 

! Most of the configuration elements of the TCX installation shown on the Configuration and 
Resource Defaults tabs are stored locally on each node, and therefore must be updated on 
each node if changed.  To update the settings, open the Configuration Utility on each node and 
update the value. 

! Updating the Sender email address and display name on the Configuration Tab must be 
updated on the active node for the change to take effect or test.  Changes here will 
automatically propagate to the other nodes when a node becomes the active node. 

! Using the features on the Operations tab of the Configuration Utility, including adding/removing 
resources, starting/stopping the synchronizer must be performed on the active node.   
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APPENDIX - USING TCX INTEGRATION WITH 
SEPARATE ADMIN ROLES 
TCX normally requires the installing and operating user be a Local Domain Administrator and an 
Exchange Full Administrator (or Exchange Recipient Administrator for Exchange 2007 Installs).  In 
some organizations, due to internal policy or security requirements, these requirements can not be 
met as these roles are explicitly separated.  This section is intended to provide additional instruction 
on how the TCX product can be installed and operated in an environment where the Active Directory 
and Exchange Administrative roles are segregated. 

Assumptions/Background 
The following are the assumptions about the customer environment for these instructions. 
! An Admin Group is responsible for creating users, groups, and mailboxes for new users. 
! An Exchange group is responsible for ongoing operation of Exchange Servers and mail 

processes. 
! The Exchange group has local administrative rights to the Exchange server, but does not have 

Domain Administrative rights. 
! The users installing the product are aware of any replication delays associated with their Active 

Directory implementation - how it affects propagation of changes in AD objects and permissions 
and any waits that are required before changes will take effect. 

! The process description assumes this is a first time installation of the TANDBERG product. 
For common terminology purposes in this guide, the user from the Admin group will be called the AD-
Admin.  The user from the Exchange group will be called the Exchange-Admin. 
! AD-Admin is a member of Domain Admins. 
! Exchange-Admin is a Local Administrator and delegated Full Exchange Administrator 

permissions (or Exchange Recipient Administrator in Exchange 2007). 

Installation 
This section will outline how to adapt the installation process to function when the Active Directory 
and Exchange Administrator roles are separated. 

Pre-Installation Steps 
1. The AD-Admin must create or decide which OU in Active Directory will be used for accounts 

related to the TCX Integration.  Accounts are not required to be in the same OU, but the policy 
should be followed for consistency with the standard product. 

2. The Exchange-Admin decides which Exchange Server and Information store will be used for 
the Exchange Integration (all mailboxes for integrated accounts must be located in information 
stores on the same Exchange Server). 

3. The AD-Admin must create a new domain user or designate an existing user to be the 
Exchange Side service user.  Example: TMS-Service.  The remainder of the instructions will 
refer to this account as TMS-Service.  When creating a new account, create a mailbox for the 
TMS-Service user.  The mailbox must be in an information store on the specified Exchange 
Server.  If re-using an existing account and the mailbox for the TMS-Service user not stored on 
the specified Exchange Server, the Exchange-Admin must move the user’s mailbox to the 
specified Exchange Server before proceeding.  The account must have a SMTP email address 
that is reachable from the mail server used by TMS. 

4. The AD-Admin must set the extensionattrbute1 property on the TMS-Service user to be ‘TMS-
Service’.   
a. Exchange 2003 - Using the AD Users and Computers tool, enable Advanced Features 

from the View Menu, open Properties for the user, select the Exchange Advanced Tab, 
click Custom Attributes and edit the value of extensionAttribute1 to be ‘TMS-Service’ 
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b. Exchange 2007 – Using Exchange Management Console, open the Properties of the 
Mailbox, on the General tab, click Custom Attributes and edit the value of 
extensionAttribute1 to be ‘TMS-Service’. 

5. The AD-Admin or Exchange-Admin must make the TMS-Service account a local Windows 
Administrator of the specified Exchange Server. 

6. The AD-Admin or Exchange-Admin must grant the ‘Log on as Batch Job’ Local Security Policy 
to the TMS-Service account on the specified Exchange Server.  Ensure no Group Policy setting 
will block or remove this permission.  See http://technet.microsoft.com/en-
us/library/cc739028.aspx for assistance on assigning user rights for your local computer. 

7. The AD-Admin must create or identify a Windows user account that can log into the TMS server 
to be the TMS Side Service user.  The user account can be a local Windows account on the 
Windows Server hosting TMS or a domain user.  We will refer to this account as tmsconfuser.   

Open a browser and log into the TMS website with a user with Site Administrator privileges.  Go to 
Administrative Tools > User Administration.  If the tmsconfuser account has never logged into 
TMS, create a new user profile.  If the account has logged in previously, find the existing user profile 
and click Edit.  Ensure the username of the profile matches the username of the service account.  Set 
the Exchange Integration Service Account value to Yes.  Set the email address of the profile to be 
the email address of the TMS-Service account created in the earlier steps.  Ensure the user is a 
member of a TMS group that has the book on behalf of permission and book permission on all 
systems that will be integrated (recommend using Site Administrator group which will allow access to 
all systems).  Save the profile and close the TMS website. 
8. If users will be given access to resource calendars so they can interact with the calendars 

directly (required if using Direct Resource Booking), the AD-Admin must create or designate an 
existing security group for the ‘Editor’ role and ‘Author’ security groups that will later be granted 
permissions to the resource’s calendars. 

Stage the Resource Accounts 
These steps will outline how to prepare a resource account for use with the TCX integration.  These 
steps should be repeated for each resource account to be integrated, and anytime you need to 
integrate a new system and be completed before trying to enable the corresponding TMS system 
using the Configuration Utility. 
1. Log into the TMS web interface and find the TMS System ID of the system that will be 

associated with this resource account.  This can be seen by looking at the View Settings page 
for the system in Navigator.  Example ID = 15 

2. If an existing resource account is going to be reused, have the Exchange-Admin move the 
mailbox to an Information Store on the Exchange Server where TCX is installed.  If no existing 
resource account is going to be reused, have the AD-Admin create a new Active Directory user 
and mailbox for the Exchange Resource account.  In Exchange 2007 Installs, be sure to create 
a mailbox of type room or equipment.  The mailbox for the user must be located on an 
Information Store on the Exchange Server where TCX is installed. 
Most of the account’s properties, such as username, password, display name, and email 
address are not significant to the Integration and can be whatever values you chose.  It is 
recommended you set the Display Name value to the same name as the matching system in 
TMS. 

3. The AD-Admin must set the extensionattribute1 property on the resource account to TMS-xx 
where xx is replaced with the numeric ID found in step 1.  Example TMS-15. 
a. Exchange 2003 - Using the AD Users and Computers tool, enable Advanced Features 

from the View Menu, open Properties for the user, select the Exchange Advanced Tab, 
click Custom Attributes and edit the value of extensionAttribute1 to be TMS-15. 

b. Exchange 2007 – Using Exchange Management Console, open the Properties of the 
Mailbox, on the General tab, click Custom Attributes and edit the value of 
extensionAttribute1 to be TMS-15. 

4. The AD-Admin must grant send as and receive as permissions for the TMS-Service account to 
this resource account.   
a. Exchange 2003 - Using AD Users and Computers, enable Advanced Features from the 

View Menu, open the Properties of the resource account.  Select the Security tab, and 
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click the Advanced Button.  Click Add and specify the TMS-service account.  A new 
window appears, change the Applies to drop-down to This object only and add the send 
as and receive as security permissions in the Allow column.  Click OK and OK again to 
close the Advanced Security window. 

b. Exchange 2007 – Use the Exchange Management Shell to grant the send as and receive 
as ExtendedRights on the resource account to the TMS-Service account.  An example is 
shown below, replace the Resource and User accounts names as necessary 
Add-ADPermission -Identity domain\ResourceName –User domain\TMS-Service  
-ExtendedRights ("send-as", "receive-as") -InheritanceType All 

5. The AD-Admin must grant full mailbox access permissions to the resource account's mailbox.   
a. Exchange 2003 - Using AD Users and Computers, open the Properties for the resource 

account.  Under the Exchange Advanced tab, click the Mailbox Rights button, Click 
Add and specify the TMS-service account.  While the TMS-Service account is selected, 
mark the checkbox for allow full mailbox access.  Click OK and OK again to close the 
properties for the resource account 

b. Exchange 2007 – Use the Exchange Management Shell to grant the full mailbox access 
on the resource account to the TMS-Service account.  An example is shown below, 
replace the Resource and User accounts names as necessary 
Add-MailboxPermission -Identity domain\ResourceName  
–User domain\TMS-Service -AccessRights FullAccess –InheritanceType All 

6. The AD-Admin must configure essential Calendar Settings for the account. 
a. Exchange 2003 – This step will be completed using the Configuration Tool and can be 

skipped here 
b. Exchange 2007 – Use the Exchange Management Shell to change the 

MailboxCalendarSetting  AutomateProcessing to AutoAccept and disable the default 
settings that change the conference title.  An example is shown below, replace the 
Resource account name as necessary 
Set-MailboxCalendarSettings –Identity domain\ResourceName  
–AutomateProcessing:Autoaccept –DeleteSubject $false  
–AddOrganizerToSubject $false 

Run the Software Installer 
Once the Pre-Installation and staging steps have been completed, the standard TCX software 
installer can be run taking note of the specific steps outlined below.  For a more detailed description of 
the software installer’s steps, see the Installation of Server Software section. 
! The Exchange-Admin user should be the user to run the installer 
! When specifying the Exchange Service User, the installer will automatically detect the pre-

staged TMS-Service user account.  Accept to use this account, and when prompted for the 
Exchange Service User Password, select I have the password and will provide it below and 
enter the password set during pre-installation. 

! When prompted for the TMS Service user account, select I have created a service user on the 
TMS server and enter the credentials of the tmsconfuser account setup during pre-installation. 

Enable the Staged Resource Accounts 
After the server software has been installed, the Exchange-Admin can use the Configuration Utility to 
enable the accounts that were previously staged by the AD-Admin.  These steps can be repeated any 
time new resource accounts have been staged and are to be added to the TCX Integration. 
1. Start up the Configuration Utility from the Start Menu as the Exchange-Admin.  The utility is 

found at Programs > TANDBERG > TANDBERG Conferencing eXtensions for Microsoft 
Exchange > TANDBERG Configuration 

2. During the self-test during the start-up of the Configuration Utility, it will detect errors with any 
accounts that have been pre-staged.  When prompted if you wish to repair them, click Yes .  
The utility will setup the sinks automatically for you. 

© 2009 TANDBERG  Page 83 of 86 



  TANDBERG Conferencing eXtensions for Microsoft Exchange – Administrator Guide 

© 2009 TANDBERG  Page 84 of 86 

3. If users are to be granted permissions to the resource calendars, the AD-Admin should have 
specified these groups during the pre-installation steps.  Switch to the Resource Defaults tab, 
and ensure the groups are set in the Resource Calendar Permissions section.  If not, use the 
Browse button to select the existing group for each setting.  Switch back to the Operations tab 
when complete to continue 

The accounts that were pre-staged will appear in the right hand column as if they were already 
enabled.  You will use the actions available in the Configuration Utility to complete the setup of the 
accounts. 
4. Highlight the accounts that have been pre-staged.  Use the shift or control keys to select 

multiple systems.  Right-click the highlighted systems and select Add Calendar Permissions.  
A pop-up window will appear showing the progress of the work.  Click Ok when complete. 

5. Repeat the previous step for each of the following actions 
a. Enable Autobooking12 
b. (Re-) Book all Meetings 

The pre-staged accounts are now properly integrated with TCX. 

Completing the Installation 
Once the initial resource accounts have been fully enabled using the Configuration Utility.  The 
remainder of the installation should be completed using the standard installation instructions under: 
Starting the Synchronizer – To be completed by the Exchange-Admin 
Configure Security Settings and Tuning- To be completed by the AD-Admin and Exchange-Admin 
Optional - Deploying the TANDBERG Form – To be completed by the Exchange-Admin 

Upgrades 
When performing an upgrade, the existing accounts remain intact, so no Staging or Pre-Installation 
steps are required by the AD-Admin.  The setup file can be run by the Exchange-Admin following the 
standard instructions. 
If the previous copy was uninstalled rather then performing an in-place upgrade, the existing resource 
accounts had their Integration elements disabled during the uninstall.  Once the software installation 
is complete, open the Configuration Utility.  The Utility will detect that the sinks are disabled on your 
resource accounts and prompt if you wish to repair them.  Click Yes when prompted and your 
accounts will be re-enabled. 

Uninstalling TCX 
The product can be uninstalled by the Exchange-Admin using the standard methods.    Optionally, if 
the resource and service accounts will not be needed for future use, the AD-Admin can safely remove 
the accounts completely.  See Complete Removal of Product for more details. 

Operational Changes 
When using separate Exchange and Active Directory administrators, not all features of the 
Configuration Utility will function because you may lack the permissions necessary.  The Utility will 
return an error if you do not have sufficient permissions to complete the task. 

                                                      
12 This is not available in the configuration utility when installed on Exchange 2007 servers.  This setting is 
only needed if doing Direct Resource Booking. 
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Operation Tab Changes 
The following action commands will not complete without AD-Admin rights 

Add Service User 
Permissions 

Reconfigure Account(s) from 
TMS 

Remove AD User(s) Detach from Integration 

Removing/Disabling Accounts 
Without full permissions, accounts can not be removed automatically using the Configuration Utility.   
To remove an account from the Integration without removing it from Exchange-only booking, do the 
following: 
1. Using the Configuration Utility, have the Exchange-Admin use the Disable Sinks action in the 

Operations tab 
2. Using AD Users and Computers, have the AD-Admin remove the following from the resource 

account 
a. the extensionAttribute1 value 
b. the send as and receive as permissions granted to the TMS-Service account 
c. the full mailbox access permission granted to the TMS-Service Account 

To remove an account from both the TCX Integration and Exchange-only booking, simply have the 
AD-Admin delete both the user account and mailbox. 

Configuration Tab Changes 
Change the Password for Service User requires AD-Admin permissions to use. 
The other settings may be configured by the Exchange-Admin. 

Resource Defaults Tab Changes 
All settings may be changed by the Exchange-Admin. 

© 2009 TANDBERG  Page 85 of 86 



  TANDBERG Conferencing eXtensions for Microsoft Exchange – Administrator Guide 

© 2009 TANDBERG  Page 86 of 86 

DISCLAIMERS AND NOTICES 
The objective of this Guide is to provide the reader with assistance in using and configuring their TCX.  Product capabilities of 
TANDBERG and other manufacturers’ products change over time and so the required configuration may be different from that 
indicated here.  If you have any suggestions for changes to this document, please feed them back to TANDBERG through your 
TANDBERG Authorized Service Representative. 

If you need technical support, please contact your TANDBERG Authorized Service Representative. 

 

The specifications for the product and the information in this Guide are subject to change at any time, without notice, by 
TANDBERG. 

Every effort has been made to supply complete and accurate information in this Guide; however, TANDBERG assumes no 
responsibility or liability for any errors or inaccuracies that may appear in this document. 

TANDBERG® is a registered trademark belonging to Tandberg ASA. Other trademarks used in this document are the property 
of their respective holders. 

This Guide may be reproduced in its entirety, including all copyright and intellectual property notices, in limited quantities in 
connection with the use of the TANDBERG product. 

Except for the limited exception set forth in the previous sentence, no part of this Guide may be reproduced, stored in a 
retrieval system, or transmitted, in any form, or by any means, electronically, mechanically, by photocopying, or otherwise, 
without the prior written permission of TANDBERG. 

www.tandberg.com. 
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